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Добро пожаловать!

Мы стремимся к тому, чтобы телевидение стало областью настоящего творчества, 

в которой любой профессионал имеет возможность создавать материал самого 

высокого качества.

Если раньше на оснащение студий вещания и постпроизводства требовались миллионы 

долларов, теперь с оборудованием компании Blackmagic Design стала доступной даже 

работа в формате Ultra HD 60p. Надеемся, что наши новые продукты, будь то UltraStudio, 

DeckLink или Intensity, станут незаменимыми помощниками и будут служить вам в течение 

многих лет.

В данном руководстве содержится вся информация, необходимая для обработки видео 

с помощью решений Blackmagic Design. Если вы раньше не устанавливали плату PCI 

Express, рекомендуем обратиться за помощью к техническому специалисту. Так как наше 

оборудование поддерживает несжатое видео с большим объемом передаваемых данных, 

вам потребуется высокоскоростной диск и мощный компьютер.

Процесс установки занимает приблизительно 10 минут. Перед ее выполнением 

посетите раздел поддержки на нашем веб-сайте www.blackmagicdesign.com/ru, где 

можно найти последние версии этого руководства и программного приложения. 

При загрузке обновлений не забудьте зарегистрировать используемое оборудование 

Blackmagic Design, чтобы своевременно узнавать о выходе очередного релиза 

и добавлении новых функций. Будем рады получить любые отзывы о решениях 

Blackmagic и даже образцы проектов, выполненных с их помощью. Мы постоянно 

работаем над совершенствованием наших продуктов, поэтому ваши отзывы помогут  

нам сделать их еще лучше!

Грант Петти 

Генеральный директор Blackmagic Design

http://www.blackmagicdesign.com/ru
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Подготовка к работе

Введение
Это руководство содержит всю необходимую информацию о системных требованиях, 
установке программного обеспечения, подключении оборудования и использовании 
продуктов других производителей.

Он включает в себя драйверы и плагины, а также утилиты Blackmagic Desktop Video 
Setup и Media Express для захвата и вывода. Программный продукт Desktop Video 
предназначен для работы с такими решениями Blackmagic Design, как UltraStudio, 
DeckLink, Intensity и Teranex. 

 

Системные требования
Объем оперативной памяти компьютера должен быть не менее 8 Гб. 

Mac OS
Приложение Desktop Video работает на платформах Mac OS El Capitan и Sierra.

Windows
Desktop Video работает только на 64-разрядной версии Windows 8 и Windows 10 с 
последним пакетом обновления.

Linux
Desktop Video можно установить на компьютеры с платформой Linux 2.6.23 и выше 
с архитектурой х86 (32- и 64-разрядные версии). Дополнительная информация 
о последних дистрибутивах Linux, форматах пакетов и зависимости программных 
продуктов содержится в сопроводительной документации.

Подключение питания
Если оборудование Blackmagic Design имеет внешний источник питания, подсоедините 
его и подключите к сети.
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СОВЕТ.  DeckLink 4K Extreme 12G можно подключить к дополнительному 
источнику энергии с использованием прилагаемого кабеля. Решение имеет 
мощный функционал, но мы всегда стараемся его расширить, например, 
с помощью установки мезонинной платы. Теперь в комплект поставки входит 
кабель, который позволяет подключить дополнительный источник питания 
в случаях, когда плата DeckLink потребляет больше энергии, чем способен 
обеспечить PCIe-слот.

 

Если нужно подключить такой источник, используйте прилагаемый кабель. 
Отключите используемый кабель от видеокарты и подключите к нему Y-образный 
кабель. Выполнить это соединение можно только одним способом.

Подключение оборудования
Подключение оборудования к компьютеру осуществляется с помощью портов 
Thunderbolt, USB 3.0 или PCIe. 

Подключение через порт Thunderbolt
Blackmagic UltraStudio 4K и UltraStudio 4K Extreme имеют по два порта Thunderbolt™ 2. Если 
ваш компьютер оснащен только одним разъемом Thunderbolt, дополнительный порт 
можно использовать для подключения RAID-массива или другого устройства. 

517Подготовка к работе



Blackmagic UltraStudio 4K Extreme 3 имеет два порта Thunderbolt™ 3, модель UltraStudio HD 
Mini — один порт Thunderbolt 3 с пропускной способностью до 40 Гбит/с. Для 
подключения оборудования Blackmagic по интерфейсу Thunderbolt 3 соедините кабель 
Thunderbolt 3 с соответствующим гнездом на компьютере. Подключение к порту 
Thunderbolt 2 через адаптер Thunderbolt 3/Thunderbolt 2 не поддерживается на 
продуктах с питанием через шину (UltraStudio HD Mini).

Убедитесь в том, что компьютер поддерживает работу с Thunderbolt 3.  
В этом случае порт USB-C имеет соответствующую маркировку (см. рис. справа).

Подключение через порт USB 3.0
Подключите оборудование к компьютеру с помощью кабеля SuperSpeed USB 3.0. 

HDMI IN Y IN Pb IN Pr IN S-VIDEO IN VIDEO IN L AUDIO IN

AUDIO OUTVIDEO OUTS-VIDEO OUTPr OUTPb OUTY OUTHDMI OUT

R

Подключение кабеля SuperSpeed USB 3.0 к Intensity Shuttle 

Подключение через PCIe
Вставьте Blackmagic Design PCIe-плату в нужный слот компьютера. Ознакомьтесь 
с информацией на упаковке платы, чтобы узнать необходимое количество слотов. 
В зависимости от типа соединения вам могут понадобиться один, четыре или восемь 
PCIe-слотов.

PCIe-платы можно устанавливать в более крупные слоты, чем требуется. Например, 
4-линейная плата совместима со слотом х16, но не наоборот.

Если информация на упаковке отсутствует, посетите раздел «Технические 
характеристики», перейдя на страницу www.blackmagicdesign.com/ru/products.
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Вставьте PCIe-плату Blackmagic Design в нужный PCIe-слот. При 
наличии скобки для HDMI установите ее в любой свободный слот PCIe и 
подсоедините к задней панели платы с помощью HDMI-кабелей.

При установке PCIe-платы DeckLink соблюдайте осторожность, 
чтобы не допустить повреждения ее компонентов.

Если имеется переходной кабель, соедините его с соответствующим портом на плате 
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Подключение UltraStudio 4K Extreme через порт PCIe

UltraStudio 4K Extreme и UltraStudio 4K Extreme 3 можно подключить к компьютеру 
через порт PCIe с помощью дополнительного адаптера и кабеля. Для этого 
используйте PCIe-слот Gen 2. Комплект Blackmagic PCIe Cable Kit, включающий 
адаптерную плату PCIe и кабель, можно приобрести у всех дилеров компании 
Blackmagic Design.

Чтобы подключить модель UltraStudio 4K Extreme, используйте Blackmagic PCIe 
Cable Kit или стандартную адаптерную PCIe-плату. 

UltraStudio 4K Extreme имеет PCIe-порт, предназначенный для подключения 
внешней платы PCIe-адаптера, установленной на компьютере

Адаптерную плату устанавливают в PCIe-слот Gen 2 компьютера

Подключите PCIe-кабель к соответствующему порту, который 
находится на задней панели компьютера 

520Подготовка к работе



Установка программного обеспечения Desktop Video

Приложения, плагины и драйверы
Программное обеспечение Blackmagic Design Desktop Video включает в себя драйверы, плагины 
и приложения, необходимые для работы с оборудованием. Ниже приведен перечень всех 
приложений, плагинов и драйверов, установленных на ваш компьютер.

Mac OS Windows Linux

Драйверы Blackmagic Desktop Video Драйверы Blackmagic Desktop Video Драйверы Blackmagic Desktop Video

Blackmagic Desktop Video Setup Blackmagic Desktop Video Setup Blackmagic Desktop Video Setup

Blackmagic Design LiveKey Blackmagic Design LiveKey –

Blackmagic Media Express Blackmagic Media Express Blackmagic Media Express

Кодеки Blackmagic QuickTime™ Кодеки Blackmagic AVI и QuickTime™ –

Blackmagic Disk Speed Test Blackmagic Disk Speed Test –

Настройки и плагины для 
Adobe Premiere Pro CC, 
After Effects CC и Photoshop CC

Настройки и плагины для 
Adobe Premiere Pro CC, After Effects 
CC и Photoshop CC

–

Плагины для Final Cut Pro X – –

Плагины для Avid Media Composer Плагины для Avid Media Composer –

Автоматические обновления
После установки программного обеспечения Desktop Video и перезапуска компьютера будет 
проверено внутреннее ПО оборудования. Если оно не соответствует версии, установленной на 
компьютер, появится диалоговое окно с предложением обновить прошивку. Выберите OK для 
запуска обновления, затем перезагрузите компьютер, чтобы завершить установку.

ПРИМЕЧАНИЕ.  Если плата DeckLink не работает из-за сбоя в обновлении, выполните 
действия, описанные в разделе «Восстановление платы DeckLink после прерванного 
обновления».

Порядок установки программного обеспечения Desktop Video для платформ Mac OS, Windows и Linux 
описан далее в этом разделе. 
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Установка для Mac OS
Для установки любого программного обеспечения необходимо обладать правами 
администратора.

1	 Убедитесь, что на компьютере установлена последняя версия драйвера. 
Перейдите по ссылке www.blackmagicdesign.com/ru/support.

2	 Запустите мастер установки Desktop Video с носителя из комплекта 
оборудования Blackmagic Design или из файла, загруженного в разделе 
поддержки на нашем веб‑сайте.

3	 Чтобы установить программное обеспечение, выберите Continue (Продолжить), 
затем Agree (Согласен), затем Install (Установить).

4	 Перезагрузите компьютер, чтобы активировать новые драйверы.

Desktop Video Installer для Mac

Первичная установка на компьютере Mac с операционной 
системой Big Sur

При первичной установке Desktop Video на компьютере Mac с операционной 
системой Big Sur или более поздней версией необходимо разрешить 
использование этого программного обеспечения.

Включение расширений на компьютере Mac с операционной системой Big Sur 
или более поздней версией

1	 При появлении сообщения безопасности выберите Open Security 
Preferences или Open System Preferences и нажмите OK.
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2	 Чтобы использовать приложение Desktop Video, выберите Разрешить.

Чтобы работать с Desktop Video, необходимо  
включить приложение в список разрешенных

3	 При получении запроса перезапустить систему нажмите кнопку Not Now.

4	 Завершите установку ПО, нажав кнопку Restart.
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Установка для Windows
1	 Убедитесь, что на компьютере установлена последняя версия драйвера. 

Перейдите по ссылке www.blackmagicdesign.com/ru/support.

2	 Откройте папку Desktop Video и запустите Desktop Video Installer.

3	 Начнется установка драйверов. Появится диалоговое окно: "Do you want to allow 
the following program to install software on this computer?" (Разрешить следующей 
программе внести изменения на этом компьютере?). Выберите "Yes" (Да), чтобы 
продолжить.

4	 После сообщения "Found new hardware" (Найдено новое оборудование) появится 
мастер установки оборудования. Выберите "Install automatically" (Автоматическая 
установка). Система обнаружит необходимые драйверы Desktop Video.

5	 После установки всех драйверов появится диалоговое окно с сообщением о том, 
что оборудование готово к использованию. Перезагрузите компьютер, чтобы 
активировать новые драйверы.

Desktop Video Installer для Windows

Установка для Linux
1	 Загрузите последнюю версию Desktop Video для Linux, перейдя по ссылке  

www.blackmagicdesign.com/ru/support.

2	 Откройте папку Desktop Video и перейдите к пакетам Desktop Video, 
которые необходимо установить на компьютер. Amd64 предназначается для 
64-разрядных процессоров Intel и AMD. Папка содержит три пакета.

	ͽ Desktopvideo содержит основные драйверы и API-библиотеки.

	ͽ Пакет desktopvideo-gui содержит Desktop Video Setup. 

	ͽ Mediaexpress содержит утилиту для захвата и вывода видео.

3	 Дважды щелкните кнопкой мыши по выбранному пакету и следуйте инструкциям 
на экране. Если появится сообщение о недостающих зависимостях, сначала 
установите их, а затем вернитесь к Desktop Video.

4	 По окончании установки перезагрузите компьютер, чтобы изменения 
вступили в силу.
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Если пакет Desktop Video для Linux отсутствует или вы хотите установить программу 
с помощью командной строки, обратитесь к файлу ReadMe, в котором подробно описаны 
необходимые действия.

Программа Desktop Video готова для установки с помощью Ubuntu Software Center

Обновления
Если ПО не установлено, можно самостоятельно проверить наличие обновлений, введя 
в командной строке текст ниже.

# BlackmagicFirmwareUpdater status

Появится сообщение примерно следующего содержания.

0:  /dev/blackmagic/io0 [DeckLink SDI 4K]  0x73  OK

1:  /dev/blackmagic/io1 [DeckLink 4K Extreme 12G]  0x0A  PLEASE _ UPDATE

Если требуется сделать обновление, введите

# BlackmagicFirmwareUpdater update 1

Чтобы получить более подробную информацию об использовании команд, в том числе 
для обновления внутреннего программного обеспечения, введите "man 
BlackmagicFirmwareUpdater".

Все готово для начала работы! После того, как оборудование подключено 
и программное обеспечение установлено, можно приступать к записи 
и воспроизведению.

Запись и воспроизведение видео 
После подключения оборудования и установки программного обеспечения Desktop 
Video можно сразу приступать к захвату и воспроизведению видео. Подключите 
источник сигнала ко входу оборудования, затем соедините монитор с выходом.

Для быстрого захвата и воспроизведения используйте приложение Blackmagic Media 
Express, которое было установлено на компьютер одновременно с программным 
обеспечением Desktop Video.

Настройка
1	 Подключите видеомонитор или телевизор к выходу оборудования 

Blackmagic Design.

2	 Подключите источник видеосигнала ко входу оборудования Blackmagic Design.
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A B NTSC
PAL
Y

SDI OUT

HDMI OUT

REMOTE

SDI IN

ANALOG VIDEO IN

REF IN
CH 1 CH 2
ANALOG AUDIO IN

B-Y R-Y

SDI OUT

+ 12V 

SDI IN

REF IN
TC IN

Ultra Studio HD Mini

URSA Mini Pro

HDTV

Подключите монитор или любой другой источник к оборудованию Blackmagic Design

Проверка записи видео
1	 Запустите Blackmagic Media Express. Выберите вкладку Log and Capture. Media 

Express автоматически подбирает формат проекта в соответствии с входящим 
видеосигналом. Источник видео будет отображаться на панели предварительного 
просмотра Media Express.

2	 Выберите Capture (Захват) в нижней части окна Log and Capture для проверки 
записи. Снова нажмите Capture, чтобы завершить проверку. Записанный клип будет 
добавлен к списку Media List в левой части Media Express.

Нажмите кнопку Capture, чтобы начать запись

Проверка воспроизведения видео
1	 Выберите вкладку Playback (Воспроизведение).

2	 Щелкните два раза на пробном клипе. Видео и аудиосигналы будут передаваться на 
монитор, подключенный к выходу оборудования.
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Blackmagic Desktop Video Setup

Обзор утилиты Blackmagic Desktop Video Setup
Blackmagic Desktop Video Setup предназначается для настройки параметров 
оборудования и отображения записываемого контента в режиме реального времени.

Запуск Blackmagic Desktop Video Setup
	ͽ При работе в операционной системе Mac OS X выберите Blackmagic Desktop 

Video в разделе System Preferences (Системные настройки) или запустите 
программу из папки Applications (Приложения). 

	ͽ При работе в операционной системе Windows 8 на экране «Пуск» введите 
Blackmagic, затем выберите Blackmagic Desktop Video Setup. На Windows 8 
утилиту Desktop Video Setup можно также запустить с панели управления.

	ͽ При работе в операционной системе Windows 10 выберите Пуск > Все 
программы > Blackmagic Design > Desktop Video > Desktop Video Setup. На 
Windows 10 утилиту Desktop Video Setup можно также запустить с панели 
управления.

	ͽ При работе в операционной системе Linux выберите Applications > Sound and 
Video > Blackmagic Desktop Video Setup. 

При открытии Blackmagic Desktop Video Setup на экране будут отображаться все 
подключенное оборудование и функции, используемые для работы с ним. При 
получении видеосигнала его формат будет автоматически распознан и отображен под 
значком Video Input.

Если подключено несколько устройств для захвата и воспроизведения, перейти от 
одного к другому можно с помощью стрелок по бокам главной страницы. Для изменения 
настроек нажмите на изображение оборудования или значок настроек под названием 
устройства.  
Desktop Video Setup отображает настройки только для выбранного оборудования, что 
избавляет от необходимости просматривать множество страниц меню в поисках нужной 
информации. 

Главная страница утилиты Blackmagic Desktop Video Setup
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Ниже описан порядок изменения настроек с помощью Blackmagic Desktop Video Setup.

Blackmagic Desktop Video Setup позволяет менять настройки 
входящего и исходящего видео- и аудиосигнала, выполнять 
повышающую и понижающую конверсию при захвате 
и воспроизведении, а также получать информацию о драйвере

Вкладка Video

Video Input
С помощью мыши выберите значок, соответствующий разъему для ввода видео. Будут 
показаны только те разъемы, которыми оснащено оборудование. При обнаружении 
сигнала его формат отображается на главной странице утилиты Blackmagic Desktop 
Video Setup. 

С помощью мыши выберите вход для ввода видео

Use XLR Timecode
Выберите эту настройку, чтобы получать тайм-код через XLR-вход, а не из SDI-потока.

Выберите эту опцию, чтобы получать тайм-код через XLR
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Уровни аналогового видео на входе
Используйте слайдеры Video и Chroma, чтобы установить уровни аналогового видео на 
входе для компонентного или композитного сигнала. С их помощью меняют яркость 
и насыщенность цвета. При работе с компонентным видео настраивать значения Cb и Cr 
можно независимо друг от друга. Для их связанной настройки щелкните кнопкой мыши 
по соответствующему значку.

Video Output
Выберите нужный стандарт видео и выполните необходимые настройки сигнала 
на выходе. 

Общая информация
	� Формат видео по умолчанию

Для вещательного мониторинга в Final Cut Pro X установите формат на выходе 
в соответствии с форматом проекта в Final Cut Pro X.

	� When Paused
Выберите воспроизведение полного кадра или одного фрагмента при 
постановке на паузу.

	� Video Playback
Выберите показ статичных изображений или черного экрана при остановке.

	� During Capture
Выберите воспроизведение видео или входящего сигнала на выходе во время 
захвата. При выборе опции "Video output displays playback video" на экране будет 
отображаться тот сигнал, который выбран в разделе Video Playback. При выборе 
опции "Video output displays input video" на выходе будет отображаться 
входной сигнал.

	� During Playback
Некоторые решения пакета Desktop Video могут выполнять преобразование на 
видеовыходе из Rec. 601 и Rec. 709 в стандарт Rec. 2020, требуемый для 
воспроизведения сигнала на телевизорах и мониторах. Если оборудование 
поддерживает эту функцию, в меню Setup выберите Convert to Rec. 2020.  
В остальных случаях оставьте настройку по умолчанию (Keep default color gamut). 

Выберите нужные опции при постановке на паузу,  
во время воспроизведения и захвата
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SDI Output
	� Color space

Задайте цветовое пространство между следующими опциями: RGB-видео с частотой 4:4:4 или 
Y, Cb, Cr 4:2:2.

	� 3G-SDI formats
Выберите вывод SDI-сигнала 3 Гбит/с по стандарту SMPTE Level A или по стандарту 
SMPTE Level B.

	� 1080p HD and 2K
Выберите вывод сигналов 1080p HD и 2K как Progressive или PSF.

Для настройки параметров выходного SDI-сигнала используйте SDI Output

	� Настройка интерфейса SDI
Выберите Single Link (одноканальную), Dual Link (двухканальную) или Quad Link 
(четырехканальную) передачу для вывода сигналов 3G, 6G или 12G-SDI. Некоторые мониторы 
и проекторы для профессиональной цветокоррекции поддерживают только 
четырехканальную передачу сигнала в форматах 2160p/60 и DCI 4K 4:4:4. UltraStudio 4K 
Extreme позволяет выводить Quad Link 3G-SD, а при использовании DeckLink 4K Extreme 12G 
можно установить дополнительную плату Quad SDI. 

Выберите одноканальную, двухканальную или четырехканальную 
передачу для вывода сигналов 3G, 6G или 12G-SDI

	� Форматы 8K
Видео в 8K выводится через четырехканальный SDI-интерфейс, для работы с которым можно 
выбрать нужный режим.

Доступны два режима вывода.

Are output as Square Division Quad Split (SQ) — вывод в конфигурации 2 х 2, где каждый из 
сегментов содержит одну четвертую часть исходного 8K-изображения в 4K-разрешении. 
Сигнал передается через четырехканальный SDI-интерфейс, а затем воссоздается целостное 
8K-изображение. Эта опция также используется в том случае, когда каждый исходящий 
сигнал нужно направить на отдельный дисплей в стене из Ultra HD-мониторов.

Are output as Sample Interleave (SI) — передача 8K-видео в виде отдельных 4K-сигналов 
с альтернативным набором пикселей через четырехканальный SDI-интерфейс 
и последующее формирование исходного видео. Эту опцию можно использовать для 
понижающей конверсии с выводом в 4K на любой из четырех выходов.

Для вывода 8K-изображения через четырехканальный интерфейс  
можно использовать одну из двух опций
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Настройки Analog Video Output
Если используемое оборудование Blackmagic Design поддерживает работу с аналоговым видео, 
можно выбрать вывод на компонентный, композитный или S-Video-интерфейс.

HDMI 3D Output 
Эта настройка задает способ вывода 3D для мониторинга через HDMI.

	� Top and Bottom
Вывод изображений левого и правого каналов по вертикали со сжатием 50%.

	� Frame Packing
Объединяет изображения левого и правого каналов в один кадр без сжатия.

	� Side by Side
Вывод изображений левого и правого каналов по горизонтали со сжатием 50%.

	� Left Eye 
Вывод изображения только левого канала.

	� Line by Line 
Изображения левого и правого каналов передаются на поочередных строках 
без сжатия.

	� Right Eye 
Вывод изображения только правого канала.

Выберите нужную опцию для настройки вывода 3D-видео через HDMI

Analog Video Output Levels
Используйте слайдеры Video и Chroma, чтобы установить уровни аналогового видео на выходе 
для компонентного или композитного сигнала. С их помощью меняют яркость и насыщенность 
цвета. При работе с компонентным видео настраивать значения Cb и Cr можно независимо друг 
от друга. Для их связанной настройки щелкните кнопкой мыши по соответствующему значку. 

Используйте слайдер Video для установки уровня композитного 
аналогового видеосигнала на выходе, Cb и Cr — для изменения 
баланса цвета при работе с компонентным видео

	� Use Betacam Levels 
В решениях Blackmagic Design используются уровни аналогового компонентного видео 
по стандарту SMPTE, что обеспечивает совместимость с большинством современного 
видеооборудования. Выберите эту опцию при работе с деками Sony Betacam SP.

	� NTSC IRE 
Выберите настройку 7.5 IRE для композитного видео NTSC, используемого в США 
и некоторых других странах. Выберите настройку 0 IRE при работе в Японии и странах, 
не использующих значение 7.5 IRE. Эта настройка не используется для форматов 
PAL и HD. 
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Выберите опцию "Use Betacam Levels" при работе с деками 
Sony Betacam SP. При использовании композитного видео 
в NTSC установите необходимое значение NTSC IRE.

Reference Input
Эта настройка помогает согласовать видео на выходе по входному опорному сигналу. 
Подобная задача часто стоит перед крупными вещательными студиями, где необходима 
точная синхронизация сигналов. Настройка синхронизации происходит на примерах. 

Настройка будет полезной в том случае, если все оборудование подключено 
к стабильному источнику опорного сигнала для сихронизации исходящих сигналов. С ее 
помощью становится возможным гладкое переключение между устройствами, 
соединенными с коммутатором или эфирным видеомикшером. 

Выберите необходимое значение при использовании  
синхронизации по опорному сигналу

Назначение разъемов на DeckLink Quad 2
Плата DeckLink Quad 2 имеет восемь мини-разъемов BNC, все из которых доступны для 
передачи SDI-сигналов в независимом режиме. Благодаря этому обеспечивается захват 
и воспроизведение нескольких разных потоков с помощью одного решения. Desktop 
Video Setup отображает плату DeckLink Quad 2 как восемь самостоятельных устройств 
DeckLink Quad, позволяя создать необходимую конфигурацию вводов и выводов. 
Каждому устройству можно присвоить свое имя, чтобы использовать его для работы 
с определенным видеосигналом.

Desktop Video Setup имеет настройки Connector Mapping, с помощью которых можно 
выполнить назначение SDI-разъемов. Следует помнить, что каждый из них закреплен за 
определенным устройством. Например, интерфейс SDI 1 используется с DeckLink Quad (1),  
SDI 2 — с DeckLink Quad (1) и DeckLink Quad (5).

Если на рабочей станции установлена плата DeckLink Quad 2,  
настройки Connector Mapping позволяют выбирать SDI-
разъем для каждого устройства DeckLink Quad

Таблица ниже содержит возможные варианты настройки SDI-разъемов, 
предназначенных для использования с каждым из устройств DeckLink Quad.
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Варианты конфигурации

Устройства DeckLink Quad SDI-разъемы

DeckLink Quad (1) SDI 1 и 2 или SDI 1

DeckLink Quad (2) SDI 3 и 4 или SDI 3

DeckLink Quad (3) SDI 5 и 6 или SDI 5

DeckLink Quad (4) SDI 7 и 8 или SDI 7

DeckLink Quad (5) SDI 2 или не используется

DeckLink Quad (6) SDI 4 или не используется

DeckLink Quad (7) SDI 6 или не используется

DeckLink Quad (8) SDI 8 или не используется

Следует помнить о том, что назначение SDI-разъема затрагивает все связанные с ним устройства. 
Например, если для DeckLink Quad (1) выбрана конфигурация SDI 1 и 2, то для DeckLink Quad 5 
автоматически задается опция «не используется», потому что эти устройства имеют общий SDI-
разъем. Если для DeckLink Quad (5) выбрать интерфейс SDI 2, для DeckLink Quad (1) будет 
автоматически применяться опция SDI 1. Чтобы избежать случайного переключения на работу 
с другим сигналом, необходимо выполнять назначение входов и выходов SDI в соответствии 
с таблицей выше.

СОВЕТ.  Если на рабочей станции есть плата DeckLink Quad, для управления которой 
используется собственное приложение на основе пакета SDK, при установке DeckLink Quad 
2 никакие изменения в системе не требуются. Возможность создания собственной 
конфигурации входов и выходов позволит расширить функционал уже имеющегося решения 
за счет дополнительных каналов передачи сигнала.

Вкладка Audio

Audio Input
Выберите значок, соответствующий разъему для ввода звука. Можно использовать один из 
четырех входов.

	� Embedded (Встроенный)
Аудиоканалы будут являться частью видеосигналов. При этом интерфейсы SDI и HDMI 
способны передавать встроенный звук.

	� AES/EBU
Цифровой аудиосигнал, который обеспечивает передачу двух каналов звука через 
один разъем.

	� XLR
Трехконтактный аудиоразъем, часто используемый в профессиональном аналоговом 
аудиооборудовании. 

	� RCA или HIFI
Разъем для приема и передачи небаласного аналогового звука при подключении 
любительского оборудования, такого как Hi-Fi-системы, DVD‑плееры и телевизоры.
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	� Microphone (Микрофон)
Фантомное питание через кабель чаще всего используется при подключении 
конденсаторных микрофонов. 

Включите опцию "Use +48V phantom power", если для микрофонов требуется 
фантомное питание. Рекомендуется снять флажок для этой опции, чтобы 
избежать повреждения микрофонов с автономным питанием. При использовании 
фантомного питания загорается светодиодный индикатор на передней панели 
UltraStudio 4K Extreme. После отключения функции Phantom Power необходимо 
подождать не менее 10 секунд перед использованием микрофона с автономным 
питанием. Фантомное питание не предусмотрено для микрофонов ленточного 
и электродинамического типа.

С помощью мыши выберите значок, соответствующий разъему для ввода звука

Для изменения уровня микрофонного аудиосигнала передвиньте слайдер

HDMI Audio Output
Эта опция позволяет преобразовать аудиоканалы формата 5.1 в конфигурацию для 
конкретного устройства HDMI-мониторинга. Для некоторых многоканальных усилителей 
домашних кинотеатров объемный звук требуется распределять по конкретным каналам. 
Если в вашем проекте материал имеет другой порядок каналов, к примеру стандарта 
SMPTE, обеспечить соответствие системе используемого AV-ресивера можно с помощью 
опции “Use 5.1 surround channel ordering”.

Обеспечение соответствия системе оборудования HDMI-мониторинга 
с помощью опции “Use 5.1 surround channel ordering”

AES/EBU
Передвиньте слайдер, чтобы установить усиление для аудиовходов и выходов AES/EBU. 
Нажмите значок сброса для установки усиления на 0 dB.

Используйте слайдер Output Level для регулировки уровня звука на AES/EBU-выходе
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Analog Audio Input Levels
Channel 1/Channel 2
Настройка усиления аналогового аудиосигналов на входе при захвате. Для связанной 
настройки обоих параметров щелкните по соответствующему значку.

Use HiFi Audio Levels
Модели UltraStudio и DeckLink оснащены профессиональными XLR-разъемами. 
При использовании этих разъемов для подключения любительского аудиооборудования 
выберите опцию "Use HiFi Audio Levels", так как уровни звука на профессиональной и бытовой 
технике различаются. Вам также потребуется переходник RCA/XLR.

Для настройки уровня аналогового аудио на входе используйте слайдеры двух каналов. Выберите 
опцию "Use HiFi Audio Levels" при подключении любительского звукового оборудования.

Analog Audio Output Levels
Channel 1/Channel 2
Настройка усиления аудиосигнала для аналогового аудио на выходе при воспроизведении 
видео. Для связанной настройки обоих параметров щелкните  
по соответствующему значку.

Значок сброса
При работе со слайдерами может потребоваться отмена изменений. В этом случае используют значок 
сброса – круглую стрелку справа от строки настроек. Нажмите на значок, чтобы установить 
усиление на 0 dB.

Вкладка Conversions

Input Conversion
Эта настройка позволяет в реальном времени выполнять повышающую и понижающую конверсию во 
время захвата видео. Выберите необходимый вид преобразования из раскрывающегося меню Input 
Conversion.

Конверсия на входе дает задержку до двух кадров, поэтому для синхронизации необходимо внести 
соответствующие изменения в тайм-код.

Display As
Выберите способ отображения видео после конверсии. В зависимости от пропорций кадра на 
входе могут быть доступны следующие опции: Letterbox, Anamorphic, Center Cut, Pillarbox, 16:9 
Zoom или 14:9 Zoom.

Output Conversion
Эта настройка позволяет в реальном времени выполнять повышающую и понижающую конверсию во 
время воспроизведения. Выберите необходимый вид преобразования из раскрывающегося меню.

Конверсия на выходе дает задержку до двух кадров, поэтому для синхронизации необходимо внести 
соответствующие изменения в тайм-код.
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Convert Analog Outputs
Выберите эту опцию, если необходимо выполнить конверсию на выходах 
аналогового видео.

Display As
Выберите способ отображения видео после конверсии. В зависимости от 
пропорций кадра на выходе могут быть доступны следующие опции: Letterbox, 
Anamorphic, Center Cut, Pillarbox, 16:9 Zoom или 14:9 Zoom. 

С помощью раскрывающего меню выберите необходимый вид преобразования 
на входе или выходе. Нажмите Save, чтобы сохранить настройку.

Таблица ниже содержит описание пропорций кадра, которые можно выбрать при 
выполнении конверсии.

Понижающая  
конверсия

Исходное  
изображение

После  
конверсии

Letterbox
Преобразование из 16:9 HD в 4:3 SD 
с черными полосами вверху и внизу кадра.

Anamorphic
Преобразование из 16:9 HD в 4:3 SD  
со сжатием по горизонтали.

Center Cut
Преобразование из 4:3 SD в 16:9 HD 
с удалением части оригинального 
изображения по обеим сторонам кадра.

Pillarbox
Отображение 4:3 SD в границах 16:9 HD 
с черными полосами по краям.

16:9 Zoom Преобразование 4:3 SD в 16:9 HD. 

14:9 Zoom
Промежуточный вариант между Pillarbox и 16:9 
Zoom. Небольшие черные полосы по краям 
с незначительной обрезкой изображения.
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Вкладка About

Драйвер
В разделе About содержится информация о текущей версии драйвера и последнем 
обновлении программного обеспечения.

СОВЕТ.  Выберите Create, чтобы создать отчет Status Report, который будет 
содержать такую информацию, как формат видео на входе и выходе, цветовое 
пространство, частота выборки, битовая глубина, сведения о драйвере, 
операционной системе и компьютере. Отчет можно сохранить в виде файла 
и использовать при обращении в центр технической поддержки. Благодаря 
небольшому размеру файл удобно отправлять по электронной почте.

Product Notes
Чтобы облегчить идентификацию устройств при работе с утилитой Desktop Video Setup, 
им можно присвоить имена. Это удобно при размещении одинаковой техники в разных 
местах и ее использовании для разных целей.

При вводе названия в поле заголовка оно сохраняется на главной странице Blackmagic 
Desktop Video Setup и отображается под значком оборудования.

Здесь же можно сохранить нужную в дальнейшем информацию, такую как серийный 
номер, дату и место покупки, контактные данные продавца.

На вкладке About содержится руководство пользователя, 
информация о версии драйвера и другие данные. С его 
помощью можно создать отчет состояния и сохранить 
дополнительные сведения об используемом оборудовании.
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Teranex Mini Smart Panel 

Подключение Teranex Mini Smart Panel
Blackmagic UltraStudio HD Mini представляет собой портативное решение для захвата 
и воспроизведения и имеет такой же форм-фактор, как конвертер Teranex Mini 
и рекордер HyperDeck Studio Mini. Дизайн этих продуктов отличается компактностью, что 
обеспечивает работу как на студии, так и за ее пределами. Их можно размещать на 
полке Teranex Mini Rack Shelf, которая позволяет установить оборудование в стойке.

Установка дополнительной панели Teranex Mini Smart Panel на UltraStudio HD Mini 
позволяет выводить видео вместе с аудиосигналом на имеющийся дисплей во время 
записи и воспроизведения. 

Встроенный ЖК-экран на Teranex Mini Smart Panel отображает поступающее 
изображение и индикаторы звука, с помощью которых можно следить за 
уровнями аудио.

Установку и замену панелей можно выполнять непосредственно во время работы без 
отключения конвертера Blackmagic UltraStudio HD Mini.

1	 Используя отвертку Pozidriv 2, открутите по два винта M3 на боковых 
поверхностях Blackmagic UltraStudio HD Mini и осторожно снимите стандартную 
переднюю панель.

2	 На внутренней стороне основной панели, в ее нижнем углу, имеется прозрачная 
пластиковая трубка. Она служит для подсветки индикатора состояния. 
Не отсоединяйте ее от передней панели.

СОВЕТ.  При обратной установке передней панели убедитесь, что 
светодиодная трубка совпадает с предназначенным для нее местом на 
панели.

3	 Совместите разъем на тыльной стороне Teranex Mini Smart Panel 
с соответствующим разъемом на лицевой поверхности UltraStudio HD Mini и до 
упора осторожно надавите на Smart Panel по направлению к устройству. Teranex 
Mini Smart Panel должна быть надежно соединена с лицевой поверхностью 
UltraStudio HD Mini.

4	 Установите винты M3 на прежнее место и закрутите их.

1

2

SET

VIDEO

MENU

AUDIO

Во время установки панели Teranex Mini Smart Panel на Blackmagic UltraStudio 
HD Mini держите панель так, чтобы пальцы находились сверху и снизу 
от разъема. Это поможет правильно выполнить соединение.

Устройство UltraStudio HD Mini, размещенное на полке, необходимо предварительно 
вынуть, чтобы иметь доступ к винтам передней панели. 
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Подробнее см. раздел "Teranex Mini Rack Shelf".

Если Blackmagic UltraStudio HD Mini находится в стойках за другим оборудованием, для 
защиты корпуса стандартную переднюю панель можно установить обратно на место.

Функции Smart Panel

ЖК-дисплей
Начальная страница, которая появляется на ЖК-дисплее Teranex Mini Smart Panel, 
содержит три параметра. На ней отображается следующая важная информация.

Teranex Mini Rack Shelf
При использовании Blackmagic UltraStudio HD Mini с таким оборудованием, как 
Blackmagic ATEM Television Studio HD или конвертеры Blackmagic Teranex Mini, можно 
приобрести полку Teranex Mini Rack Shelf, которая позволяет расположить устройства 
в стойке или дорожном кейсе. Teranex Mini Rack Shelf имеет размер 1 RU и позволяет 
разместить до трех конвертеров Teranex Mini. 

В этом случае необходимо снять резиновые вставки в основании корпуса и закрепить 
устройство с помощью винтов, используя монтажные отверстия.

UltraStudio HD Mini

В комплект поставки Teranex Mini Rack Shelf входят две пустые панели для заполнения 
свободного места при установке одного или двух устройств.

Подробнее см. веб-сайт компании Blackmagic Design www.blackmagicdesign.com/ru.

Buffer – количество кадров, 
сохраняемых в буфере 
устройства при захвате 
или выводе сигнала

Source – тип источника 
видео на входе (SDI, 
YCbCr или NTSC/PAL)

1 MENU

2 VIDEO

SET AUDIO

Source

YCbCr
Video Format

525i59.94 NTSC
Buffer

55 fr

Дисплей – отображается входящий 
сигнал с устройства, подключенного 
к UltraStudio HD Mini

Индикаторы звука – 
уровень звука в источнике 
видео, подключенного 
к UltraStudio HD Mini

1 MENU

2 VIDEO

SET AUDIO

Source

YCbCr
Video Format

525i59.94 NTSC
Buffer

55 fr

Video Format – используемый 
формат видео при 
захвате или выводе
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Передняя панель управления 
на модели UltraStudio 4K Mini
На UltraStudio 4K Mini большинство настроек, задаваемых с использованием утилиты Desktop Video 
Setup, можно также изменять и с помощью меню на ЖК-дисплее передней панели.  
Для навигации по настройкам нажмите кнопку MENU. Переход между опциями выполняется 
поворотной ручкой. Чтобы войти в подменю и подтвердить установленную настройку,  
нажмите кнопку SET.

Чтобы выйти из меню, повторно нажимайте кнопку MENU, пока не вернетесь на начальную страницу.

СОВЕТ.  Чтобы не тратить время на прокрутку списка параметров, а перейти сразу в раздел 
видео- или аудионастроек, нажмите соответственно кнопку VIDEO или AUDIO.

Audio Meters

VU (-18dBFS)

VU (-20dBFS)

PPM (-18dBFS)

PPM (-20dBFS)

Изменение настроек модели UltraStudio 4K Mini с помощью меню на ЖК-дисплее передней панели

Настройки звука
В экранном меню модели UltraStudio 4K Mini есть также дополнительные аудионастройки.  
Они позволяют изменять тип индикаторов звука, отображаемых во время записи и воспроизведения. 
Имеется две опции: VU и PPM.

VU
VU означает «единицы громкости». Этот индикатор усредняет крайние значения аудиосигнала. 
При использовании данной опции откорректируйте выходные уровни источника таким 
образом, чтобы пиковые значения не превышали 0 дБ. Это максимально увеличивает 
соотношение «сигнал – шум» и обеспечивает самое высокое качество аудиодорожки. Если 
пиковые значения превышают уровень 0 дБ, возникает риск искажения звука. Когда на 
UltraStudio 4K Mini используется аналоговый интерфейс, входные уровни можно регулировать 
с помощью экранного меню или утилиты настройки.

PPM
PPM означает «индикация пиков». Этот индикатор наглядно фиксирует пиковые значения, 
чтобы их было легко отследить.

Индикаторы VU и PPM позволяют выбирать опорное значение -18 дБ или -20 дБ, чтобы вести 
мониторинг на основе разных международных стандартов.

Слот для SD-карт
На передней панели также имеется слот для SD-карт, который используется для считывания и записи 
файлов, когда модель UltraStudio 4K Mini подключена к ПК или станции Mac. Компьютер 
автоматически распознает этот слот и добавляет его в список доступных дисков. Такой функционал 
позволяет быстро импортировать клипы с карты камеры, а также выбирать в настройках Media 
Express переносной носитель в качестве места для записи клипа.
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DaVinci Resolve

Интерактивный грейдинг в DaVinci Resolve
Desktop Video 10 поддерживает одновременный захват и воспроизведение с помощью 
4K- и 8К-оборудования производства Blackmagic Design. Это идеальное решение для тех, 
кто выполняет цветокоррекцию в DaVinci Resolve, так как им не придется использовать 
два отдельных устройства для ввода и вывода.

Для интерактивного грейдинга достаточно соединить выход камеры с входным 
разъемом оборудования Blackmagic Design. После этого подключите монитор для 
установки цвета и просмотра материала в реальном времени.

Настройка
1	 Запустите DaVinci Resolve. В меню Preferences перейдите на вкладку Video and 

Audio I/O и выберите необходимое оборудование в опции For Resolve Live use. 
Сохраните настройки и перезапустите приложение DaVinci Resolve.

2	 Откройте проект и перейдите к диалоговому окну Project Settings. На вкладке 
Master Settings укажите разрешение монтажной линейки и кадровую частоту, 
соответствующие подключенной камере.

3	 Перейдите на вкладку Capture and Playback и в меню Video capture and playback 
выберите необходимый формат.

В меню Video capture and playback выберите необходимый формат

4	 Перейдите на страницу Edit и выберите File > New Timeline.

5	 На странице Color щелкните по меню Color и выберите Resolve Live > On. 
Появится изображение живого видео, над которым загорится красная кнопка 
Resolve Live.

541DaVinci Resolve



Работа с Resolve Live
1	 В режиме Resolve Live кнопка Freeze (значок снежинки) способна «заморозить» входящий 

видеокадр, что позволит работать со статичным изображением. После необходимой 
обработки можно «разморозить» кадр для создания моментального снимка.

2	 Если результат цветоустановки удовлетворительный, нажмите кнопку Snapshot (значок 
камеры), чтобы сохранить моментальный снимок текущего статичного изображения в 
окне Viewer, данные тайм-кода и цветовую схему на монтажной линейке. Каждый снимок 
представляет собой однокадровый клип. После сохранения снимка вновь нажмите кнопку со 
значком снежинки, чтобы продолжить воспроизведение и перейти к следующему кадру для 
выполнения грейдинга.

СОВЕТ.  Дополнительная информация о функции Resolve Live содержится в руководстве по 
работе с DaVinci Resolve.

Редактирование в DaVinci Resolve
Blackmagic DaVinci Resolve имеет все необходимые инструменты для профессионального 
редактирования и конечной обработки. Приложение позволяет одинаково легко использовать весь 
функционал при работе с мышью и клавиатурой.

Настройка
1	 Запустите DaVinci Resolve. В меню Preferences перейдите на вкладку Video and Audio I/O 

и выберите необходимое оборудование в опции For capture and playback use. Сохраните 
настройки и перезапустите приложение DaVinci Resolve.

2	 Откройте проект и в меню File выберите Project Settings. Перейдите к настройкам Master 
Settings и выберите параметры Timeline resolution (Разрешение монтажной линейки), Timeline 
frame rate (Кадровая частота монтажной линейки) и Playback frame rate (Кадровая частота 
воспроизведения).

3	 В блоке Video monitoring (Мониторинг видео) установите настройку Video format 
(Формат видео). С помощью утилиты Blackmagic Desktop Video Setup формат видео 
будет автоматически изменен на тот, который был выбран для вывода на оборудование 
Blackmagic Design.

4	 Нажмите Save для сохранения изменений и выхода из настроек проекта.

Окно Project Settings позволяет выбирать формат  
монтажной линейки и варианты мониторинга
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Редактирование
1	 На странице Media загрузите клипы в библиотеку медиаматериалов с помощью 

браузера Media storage.

2	 На странице Edit выберите File > New timeline, введите название монтажной 
линейки и нажмите кнопку Create (Создать).

3	 Теперь можно перетащить клип из библиотеки Media Pool в расположенное 
слева окно исходного изображения.

4	 С помощью клавиш I и O и перетаскивания курсора в строке ниже окна 
просмотра можно задать точки входа и выхода в клипах.

5	 Для редактирования клипа перетащите его из окна исходного изображения на 
монтажную линейку.

СОВЕТ.  Дополнительную информацию о редактировании в DaVinci Resolve 
можно найти в руководстве пользователя Blackmagic DaVinci Resolve.

Работа с программами других 
производителей 

Adobe After Effects CC

After Effects CC

Просмотр видео
Для вывода клипов в режиме реального времени через оборудование 
Blackmagic Design перейдите в Preferences (Настройки) > Video preview (Просмотр видео). 
Чтобы использовать решения Blackmagic Design с приложением After Effects CC, нужно 
включить программный интерфейс Enable Mercury Transmit. Выберите Video Device, затем 
Blackmagic Playback. Теперь созданные при помощи After Effects клипы можно выводить 
на вещательный монитор в точном цветовом пространстве.
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Настройки Video Preview 

Если вы работаете с нестандартными или неподдерживаемыми пропорциями кадрами, 
для вывода через оборудование Blackmagic Design можно выбрать нужные размеры. 
Перейдите в Preferences > Video preview и нажмите Setup рядом с Blackmagic playback. 
Откроется окно Blackmagic device selection. Выберите масштаб изображения, который 
ближе всего к поддерживаемым пропорциям кадра. Например, если вы работаете 
с UltraStudio 4K и используете разрешение 2048 x 1152 для композитинга в After Effects, 
то при уменьшении масштаба выходным форматом будет DCI 2K, при увеличении 
— Ultra HD.

Рендеринг
После создания композитинга возможен рендеринг в виде DPX-файла или в одном из 
кодеков, указанных ниже.

Настройки Output Module Settings
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Кодеки QuickTime на Mac OS
	� Blackmagic RGB (10 бит, без компрессии)

	� Apple Uncompressed YUV 4:2:2 (10 бит)

	� Apple Uncompressed YUV 4:2:2 (8 бит) 

	� Apple Photo - JPEG (с компрессией)

	� Apple DV - NTSC (с компрессией)

	� Apple DV - PAL (с компрессией)

Другие кодеки, такие как ProRes и DVCPRO HD, будут доступны, если на компьютере 
установлена программа Final Cut Pro.

Кодеки AVI на Windows
	� Blackmagic 4:4:4 (10 бит, без компрессии)

	� Blackmagic 4:2:2 (10 бит, без компрессии)

	� Blackmagic HD 4:2:2 (8 бит, без компрессии)

	� Blackmagic SD 4:2:2 (8 бит, без компрессии)

	� Blackmagic MJPEG (8 бит, с компрессией)

Другие кодеки, такие как DVCPRO HD и DVCPRO50, будут доступны, если на компьютере 
установлена программа Premiere Pro CC.

Кодеки QuickTime на Windows
	� Blackmagic RGB (10 бит, без компрессии)

	� Blackmagic (10 бит, без компрессии)

	� Blackmagic (8 бит, без компрессии)

	� Apple Photo-JPEG (с компрессией)

	� Apple DV - NTSC (с компрессией)

	� Apple DV - PAL (с компрессией)

Adobe Photoshop CC

Photoshop CC
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Импорт и экспорт видеокадров

Импорт изображения в Photoshop CC
1	 Выберите File > Import > Blackmagic image import.

2	 Выберите Video Input Format и Image Bit Depth, затем нажмите Import Image.

Импорт изображения

Экспорт изображения из Photoshop CC
1	 Выберите File>Export>Blackmagic Image Export.

2	 Выберите Video Output Format и нажмите Export Image.

Экспорт изображения

После первоначальной настройки опций Import или Export последующие операции 
импорта и экспорта будут выполняться без отображения окна настроек. Если настройки 
необходимо изменить, удерживайте нажатой клавишу Option на Mac или Ctrl на Windows 
при выборе изображения для импорта или экспорта.

Adobe Premiere Pro CC

Premiere Pro CC
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Создание проекта Blackmagic Design
1	 Откройте приложение Premiere Pro и выберите New Project (Новый проект). 

Введите имя проекта и укажите место для его сохранения.

2	 Если Mercury Playback Engine в Premiere Pro CC поддерживает работу с вашей 
видеокартой, будет доступна опция Renderer. Для нее необходимо выбрать 
настройку “Mercury Playback Engine GPU Acceleration”.

3	 В раскрывающемся меню Capture Format выберите опцию Blackmagic Capture. 
Нажмите Settings (Настройки на Mac) или Properties (Свойства на Windows), чтобы 
установить Video Standard (Стандарт видео) и Video Format (Формат видео), 
а также задать настройки захвата видео-и аудиосигнала. Щелкните ОК для 
возврата к окну New Project.

4	 Щелкните на вкладке Scratch Disks, чтобы указать путь к местам хранения 
записанного видео и аудио. Нажмите ОК. Будет открыт новый проект. Убедитесь  
в том, что для звука по умолчанию не выбрана опция Blackmagic Desktop Video.

5	 При работе в операционной системе Mac перейдите к настройкам System 
Preferences, выберите Sound (Звук) и убедитесь, что на вкладке Output (Выход) 
не выбрано оборудование Blackmagic. На вкладке Input (Вход) укажите вход 
микрофона и вновь проверьте, что не выбрано оборудование Blackmagic.

При работе в операционной системе Windows перейдите на Панель задач и 
щелкните правой клавишей мыши по значку динамика, чтобы открыть звуковые 
настройки. Выберите вкладку Воспроизведение и настройте компьютер на 
использование звуковой платы или звукового оборудования, отличного от 
решений Blackmagic Design. Выберите вкладку Запись и настройте компьютер на 
использование записывающего оборудования, отличного от решений 
Blackmagic Design.

6	 Вернитесь в приложение Adobe Premiere Pro и перейдите Preferences > Audio 
hardware. С помощью раскрывающегося меню задайте Default Output (Вывод по 
умолчанию) на Built-in Output (Встроенный вывод). Для параметра Output Mapping 
выберите настройку Adobe Desktop Audio в поле Map Output for.

При выборе настроек аудио (Audio Hardware) в приложении Adobe Premiere Pro убедитесь, 
что для настроек Default Output и Output Mapping выбраны опции Built-in Output
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7	 В Playback блока Preferences перейдите к раскрывающемуся меню Audio Device, 
выберите настройку Blackmagic Playback и проверьте, что в поле Video Device 
стоит флажок напротив опции Blackmagic Playback. Нажмите ОК.

Выберите настройку Blackmagic Playback в меню Audio 
Device секции Playback и убедитесь, что в поле Video Device 
стоит флажок напротив опции Blackmagic Playback 

8	 Чтобы создать новую последовательность, выберите File > New > Sequence. 
Установите необходимые настройки, присвойте имя новой последовательности и 
нажмите ОК.

Создание новой последовательности с помощью 
настроек Blackmagic Design
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Управление устройствами
Многие решения Blackmagic Design для захвата и воспроизведения имеют порт RS-422 
для управления деками. Выберите Preferences > Device Control и убедитесь, что в меню 
Devices (Оборудование) включена опция Blackmagic Device Control. Нажмите OK.

Воспроизведение
Если вы работаете с нестандартными или неподдерживаемыми пропорциями кадрами, 
для вывода через оборудование Blackmagic Design можно выбрать нужные размеры. 
Перейдите в Preferences > Playback и нажмите Setup рядом с Blackmagic Playback. 
Откроется окно Blackmagic device selection. Выберите масштаб изображения, который 
ближе всего к поддерживаемым пропорциям кадра. Например, если вы работаете 
с UltraStudio 4K и используете разрешение 3996 x 2160 для последовательности 
Premiere, то при уменьшении масштаба выходным форматом будет DCI 2K, при 
увеличении — Ultra HD.

Выберите вариант вывода при использовании  
неподдерживаемых пропорций кадра

Если устройство из пакета Desktop Video поддерживает работу с HDR-материалом, для 
него можно задать цветовую палитру и систему передачи (HLG и PQ по Rec. 2020). Для 
настройки HDR mastering необходимо установить максимальное значение яркости, 
поддерживаемое монитором или телевизором.

Захват

Для захвата видео нажмите: 
File > Capture [F5]

Введите необходимые имена пленки и клипа.
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Выполните настройки захвата и управления устройствами в окне Capture

Чтобы приступить к захвату видео на устройстве без дистанционного управления, 
нажмите красную кнопку записи [G].

Чтобы задать параметры регистрации клипа через порт RS-422, введите значения In и 
Out с помощью кнопок Set In и Set Out или вручную укажите тайм-код и нажмите Log Clip. 
Введите имя клипа и нажмите ОК. В окне Project появится пустой клип. Повторите эти 
шаги для регистрации всех клипов, предназначенных для пакетной записи. 

Затем выберите File > Batch Capture [F6]. Поставьте галочку напротив Capture with handles 
и укажите количество кадров, которые вы хотите добавить в начале и в конце каждого 
клипа, затем нажмите ОК. Появится запрос для ввода пленки. Нажмите ОК, после чего 
клипы будут сохранены.

Экспорт на пленку 
Для переноса монтажной линейки на внешнюю деку используйте функцию Edit To Tape 
(Монтаж на пленку) в Premiere Pro. Доступны два варианта экспорта: Insert и Assemble. В 
первом случае необходимо иметь непрерывный тайм-код для всего проекта, который 
будет записан на ленту. Также это удобно при замене определенного кадра на 
существующей пленке. Во втором случае необходимо создать изображение с черным 
полем до места, находящегося сразу после начальной точки тайм-кода 
последовательности. Так как при редактировании в режиме Assemble предыдущая 
запись стирается, его не следует выполнять, если на ленте уже есть другие проекты.

Для экспорта на внешнюю деку используйте функцию Export to tape 
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СОВЕТ.  При экспорте на пленку в режиме Assemble рекомендуется всегда добавлять 
минимум 30 секунд черного изображения в конце последовательности. Это поможет при 
постобработке и позволит избежать появления нежелательного контента сразу после записи 
материала.

Экспорт на ленту через порт RS-422
1	 Чтобы проверить корректность настроек в приложении Adobe Premiere Pro, обратитесь к 

разделу «Создание проекта Blackmagic Design» выше.

2	 Откройте окно Edit To Tape в Premiere Pro и перейдите File > Export > Tape (serial device). 
Выберите Recorder Settings, затем Blackmagic Capture и Settings. Укажите стандарт и формат 
видео вместе с настройками аудиосигнала. Нажмите OK. Если формат захвата не совпадает 
с форматом выходного сигнала, это может привести к сбою в работе деки, поэтому экспорт 
аудио будет невозможен.

3	 Задайте Export Type (Тип экспортирования). Для этого выберите в раскрывающемся меню 
Assemble или Insert, укажите точку ввода и нажмите Record.

При монтаже на ленту программа будет ждать на первом кадре проекта, чтобы начать запись 
в соответствии с заданным тайм-кодом. Если во время монтажа первый кадр утерян или 
продублирован, следует изменить параметры смещения, выбрав Playback > Video device > Offset. Это 
позволит синхронизировать компьютер и деку. Подобную синхронизацию достаточно выполнить один 
раз, после чего все настройки будут сохранены.

Настройки звука необходимо менять только при использовании функции Export to tape. По окончании 
работы не забудьте вернуть старые настройки звука на компьютере.

Adobe Character Animator CC
Некоторые устройства из пакета Desktop Video позволяют направлять графику, созданную в 
приложении Adobe Character Animator CC, на другое оборудование (например, телесуфлер). В этом 
случае в программе можно использовать виртуальных персонажей и в реальном времени 
отслеживать эту анимацию.

Ниже описан порядок вывода материала из Adobe Character Animator CC.

1	 В приложении Adobe Character Animator выберите Character > Preferences > Live Output.

2	 Убедитесь в том, что для опции “Enable Mercury Transmit and Syphon” поставлен флажок.

3	 Выберите Blackmagic Playback.

4	 Для Blackmagic Playback выберите Setup.

5	 В раскрывающемся меню Output Mode выберите один из перечисленных ниже режимов.
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Playback
Вывод напрямую из приложения Adobe Character Animator CC без выполнения кеинга.

Internal Keying
Эта опция позволяет с помощью внутреннего кеинга на устройстве из пакета Desktop Video 
добавлять виртуального персонажа поверх изображения из другого источника. Фоном может 
служить место из новостного сюжета или вещательный сигнал, а анимация становится 
дополнительным слоем, который делает визуальный ряд программы более интересным.

Fill/Key
Этот режим используется в тех случаях, когда кеинг необходимо выполнить внешним способом 
(например, на микшере ATEM). Заполняющим сигналом является анимация, а вырезающим — 
полутоновая маска, которая определяет границы прозрачной области. Виртуальный персонаж будет 
помещен на выбранный фон.

Final Cut Pro X
Приложение Final Cut Pro X имеет настройку A/V Output, которая позволяет выводить видео через 
оборудование Blackmagic Design. Если устройство из пакета Desktop Video поддерживает работу с 
HDR-материалом, его можно просматривать и редактировать в широком динамическом диапазоне 
при использовании совместимого телевизора или монитора.

Final Cut Pro X

Настройка Final Cut Pro X
1	 Убедитесь в том, что вы работаете с Final Cut Pro X 10.0.4 или более поздней версией, а на 

компьютере установлено последнее обновление операционной системы Mac OS.

2	 Откройте утилиту Blackmagic Desktop Video Setup. Перейдите к раскрывающемуся меню 
Video standard и выберите формат, который будет использоваться для проекта в Final Cut 
Pro X, например 2160p/29,97. Он должен совпадать с форматом клипов. Эта настройка также 
определяет режим вывода видео для мониторинга.

Установите формат на выходе, совпадающий с форматом проекта в Final Cut Pro X
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3	 Перейдите к раскрывающемуся меню Pixel format и установите настройку, 
которая будет соответствовать формату на телевизоре или внешнем мониторе. 
Например, если вы работаете с HDR-материалом, выберите 10-bit YUV 4:2:2 или 
10-bit RGB 4:4:4 в зависимости от характеристик монитора.

4	 Перейдите к раскрывающемуся меню Color gamut и выберите настройку, которая 
соответствует цветовой палитре проекта: Rec. 601/Rec. 709 (для SD- или HD-
проектов со стандартным динамическим диапазоном), Rec. 2020 (если устройство 
из пакета Desktop Video поддерживает работу с HDR и вы ведете монтаж 
видео в 4K или с расширенным динамическим диапазоном), Rec. 2020 HLG или 
Rec. 2020 PQ (4K-материал в HDR). Эта настройка должна быть совместимой 
с форматом телевизора или монитора.

После настройки параметров вывода на дисплей можно создать новый проект 
в Final Cut Pro X.

Создание нового проекта
1	 Откройте приложение Final Cut Pro X. В свойствах библиотеки будет 

отображаться принятое по умолчанию обозначение проекта без названия. 
Нажмите на соответствующий значок Modify. Перейдите к меню File, затем 
выберите New > Library, чтобы создать новую библиотеку.

СОВЕТ.  Если после создания новой библиотеки ее свойства не 
отображаются в правой части экрана, нажмите на значок хлопушки 
в верхнем левом углу. Будет открыта боковая панель.

2	 На боковой панели выберите новую библиотеку и нажмите на соответствующий 
значок Modify. Откроется окно для установки цветового пространства проекта. 
Выберите опцию Standard (для SD- или HD-проектов со стандартной цветовой 
палитрой) или Wide Gamut HDR (при работе с HDR-материалом).

3	 Нажмите Change, чтобы подтвердить настройку.

4	 Щелкните правой кнопкой мыши по названию библиотеки на боковой панели 
и выберите New Project, чтобы создать новый проект. Укажите имя и выберите 
событие, к которому относится проект. Если оно еще не создано, можно 
использовать настройку по умолчанию, которая соответствует текущей дате.

5	 Нажмите кнопку Use Custom Settings. Для настройки Video выберите опции 
Format, Resolution и Rate. Они должны соответствовать формату и кадровой 
частоте, которые заданы с помощью утилиты Desktop Video Setup.

6	 В поле Rendering выберите предпочтительный кодек Apple ProRes или несжатое 
10-битное видео 4:2:2.
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7	 На стандартном HD-проекте цветовое пространство менять не нужно, потому что 
будет автоматически применяться настройка Rec. 709. Если вы работаете с HDR-
материалом, выберите цветовое пространство и систему передачи (PQ или HLG)  
в зависимости от технических характеристик телевизора или монитора.

8	 Для настройки Audio/Channels выберите опцию Stereo. При наличии шести 
аудиоканалов можно использовать опцию Surround. Для настройки Audio/Sample 
Rate выберите 48kHz.

9	 Нажмите ОК, чтобы завершить создание нового проекта. Если подключен 
внешний HDMI- или SDI-монитор, необходимо убедиться, что новый проект 
выводится корректно.

Настройка параметров вывода в Final Cut Pro X
1	 Перейдите к меню Final Cut Pro. Выберите Preferences и вкладку Playback. 

Убедитесь в том, что для настройки A/V Output выбрана опция Blackmagic, а 
формат видео соответствует параметрам проекта. Закройте окно Preferences.

2	 В строке меню перейдите к Window и выберите A/V Output, чтобы выводить 
видео с помощью оборудования Blackmagic Design.

Настройка вывода звука на Mac OS
1	 Откройте «Системные настройки» и нажмите значок «Звук».

2	 Перейдите на вкладку «Вывод» и выберите Blackmagic Audio.

СОВЕТ.  С помощью аппаратного устройства из пакета Desktop Video 
можно вести мониторинг звука.

Воспроизведение
1	 Импортируйте несколько клипов в новый проект.

2	 Теперь с помощью монтажной линейки Final Cut Pro X можно осуществлять 
предварительный просмотр видео, выводя его на экран монитора или 
телевизора, подключенного к оборудованию Blackmagic Design.

Запись видео и аудио
Запись видео и аудио на оборудование Blackmagic Design можно вести с помощью 
приложения Blackmagic Media Express. После сохранения клипы импортируют в Final Cut 
Pro X для последующего монтажа.

При использовании приложения Media Express для записи клипов убедитесь в том, что  
Final Cut Pro X поддерживает выбранный видеоформат (Apple ProRes 4444 XQ, ProRes 
4444, ProRes 422 HQ, ProRes 422, ProRes 422 LT или Uncompressed 10-bit 4:2:2).

Монтаж на ленту
Завершив проект в Final Cut Pro X, создайте на его основе видеофайл, который после 
обработки с помощью Blackmagic Media Express можно использовать для создания 
пленочной мастер-копии на оборудовании Blackmagic Design.

1	 Выберите клипы из монтажной линейки Final Cut Pro X.

2	 Выберите File>Share>Master File. Откроется окно Master File.

3	 Нажмите Settings и выберите нужный видеокодек из раскрывающегося меню.
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4	 Нажмите Next и выберите место хранения для клипа, затем нажмите Save.

5	 Откройте Media Express и импортируйте клип, экспортированный 
из Final Cut Pro X.

6	 Дополнительную информацию о монтаже видео- и аудиофайлов на ленту можно 
найти в разделе о работе с Blackmagic Media Express.

Avid Media Composer
Avid Media Composer позволяет записывать и воспроизводить видео и звук с помощью 
оборудования Blackmagic Design в стандарте 4K, а также поддерживает работу с портом 
RS-422 для управления декой. Плагины Blackmagic для Media Composer загружаются 
автоматически в том случае, если приложение Media Composer было установлено ранее 
Desktop Video.

Avid Media Composer

Настройка
1	 Запустите Media Composer. Откроется диалоговое окно Select Project.

2	 Выберите User Profile, если такой профиль уже создан.

3	 Выберите папку, в которой будет храниться проект: Private, Shared или External.

4	 Нажмите кнопку New Project.
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5	 Присвойте имя проекту и выполните настройку опций Format, Color Space и 
Stereoscopic. Нажмите OK. Настройки Color Space и Stereoscopic можно изменить, 
перейдя на вкладку Format. 

Укажите имя проекта и задайте его настройки

6	 Щелкните кнопкой мыши дважды по имени проекта в диалоговом окне Select 
Project. Появится экран Media Composer с окном нового проекта. Процесс 
подготовки проекта к началу работы завершен.

Воспроизведение
Чтобы проверить все подключения, перейдите к Help Menu, щелкните Read Me и 
выберите Media Composer Editing Guide. Следуйте инструкциям в разделе Importing Color 
Bars and Other Test Patterns. Щелкните кнопкой мыши дважды по файлу для его 
воспроизведения. Изображение должно появиться на компьютерном мониторе и на 
оборудовании Blackmagic Design.

Если изображения нет, проверьте соединения и настройки Blackmagic Design. Для этого 
выберите Tools > Hardware Setup в приложении Media Composer. Убедитесь, что значок 
аппаратного устройства над монтажной линейкой находится в активном режиме.

ПРИМЕЧАНИЕ.  При работе с внешним видеоустройством, например Blackmagic 
UltraStudio 4K, перед запуском приложения Media Composer проверьте наличие 
питания и подключение.

Захват видео с устройств без функции дистанционного управления
Многие устройства, включая современные камеры и дисковые рекордеры, а также 
камеры предыдущего поколения и видеомагнитофоны, не имеют функции 
дистанционного управления. 

Запись видео без функции дистанционного управления выполняют в описанном 
ниже порядке.

1	 Выберите File > Input > Tape Capture, чтобы открыть Capture Tool.

2	 Нажмите на кнопку Toggle Source, чтобы вместо значка деки появился значок 
земли с плюсом. Это означает, что управление декой отключено.
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В настроиках Capture Tool нажмите кнопку Toggle 
Source, чтобы записывать видео без функции 
дистанционного управления декой

3	 Выберите нужные видео- и аудиоканалы с маркировкой V и A1, A2 и т. д. С 
помощью раскрывающегося меню установите настройку Blackmagic для 
Video и Audio.

4	 В меню Bin выберите Target Bin из списка папок.

5	 В меню Res (Разрешение) выберите нужный кодек для работы с клипами. В 
данном случае это DNxHD175x для HD-видео (10 бит).

6	 Выберите диск, на котором вы хотите сохранить записанное видео и аудио. С 
помощью кнопки Single/Dual Drive Mode укажите, как будут храниться видео и 
аудио: вместе на одном диске или на различных дисках. В меню Target Drives 
выберите диски для сохранения записанного материала.

7	 Нажмите кнопку Tape Name?, после чего откроется диалоговое окно Select 
Tape. Добавьте название пленки или выберите ранее использованный носитель 
из списка.

8	 Убедитесь, что устройство готово к работе, затем нажмите кнопку Capture. Она 
замигает красным во время записи. Чтобы остановить запись, еще раз нажмите 
кнопку Capture.
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Захват на UltraStudio, DeckLink и Teranex с устройств, имеющих функцию 
дистанционного управления
Если у вас есть дека с портом RS-422, перед началом записи нужно настроить ее 
параметры.

1	 Соедините видеооборудование Blackmagic Design и деку с помощью 
последовательного кабеля через порт RS-422. Включите режим Remote. При 
работе с внешним устройством перед запуском приложения Media Composer 
проверьте наличие питания и подключение. 

2	 В проектном окне выберите вкладку Settings и щелкните кнопкой мыши дважды 
по Deck Configuration.

3	 В диалоговом окне Deck Configuration нажмите Add Channel, выберите для 
Channel Type настройку Direct, для Port — RS-422 Deck Control. Нажмите ОК и на 
вопрос “Do you want to autoconfigure the channel now?” выберите ответ “No”.

4	 Нажмите Add Deck, затем выберите марку и модель вашей деки в меню Device. 
Задайте длительность паузы перед захватом видео. Нажмите ОК, затем Apply.

5	 Дважды щелкните кнопкой мыши Deck Preferences под вкладкой Settings.

6	 Чтобы выполнить монтажное редактирование, включите опцию “Allow assemble 
edit & crash record for digital cut”. Если эта опция не выбрана, будет возможен 
монтаж только в режиме вставки. Нажмите OK.

СОВЕТ.  При появлении ошибки “Failed to find coincidence point on tape” 
для продолжения работы можно выбрать опцию Relax coincidence point 
detection в меню Deck Preferences.

В настройках деки включите опцию "Relax 
coincidence point detection"
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Порядок мгновенного запуска записи
1	 Выберите File > Input > Tape Capture, чтобы открыть Capture Tool. После того как 

дека распознана и в нее вставлена пленка или диск, можно ввести имя пленки 
или выбрать ее из списка.

2	 Кнопка Toggle Source должна показывать значок деки. Если появился значок 
спутника, нажмите на кнопку, чтобы включить управление декой, после чего знак 
изменится на изображение деки. 

3	 Кнопка Capture/Log Mode должна показывать значок CAP. Если отображается 
значок LOG, нажмите на него, чтобы переключиться в режим записи. После этого 
должен появиться значок CAP. 

4	 Если в окне тайм-кода отображается текст “NO DECK” или имя деки 
показано курсивом, выберите Check Decks в раскрывающемся меню. После 
восстановленного управления декой ее имя не имеет курсива. Попробуйте 
использовать горячие клавиши J, K и L для управления декой.

5	 Выберите Blackmagic для входящих аудио- и видеосигналов. Укажите исходные 
видео- и аудиодорожки, целевую папку, разрешение, целевой диск и название 
пленки так же, как описано в разделе «Захват видео с устройств без функции 
дистанционного управления».

6	 Откройте окно Deck Controller в Capture Tool, чтобы перемотать ленту и начать 
воспроизведение.

7	 Нажмите кнопку Capture. Она замигает красным во время записи. Чтобы 
остановить запись, еще раз нажмите кнопку Capture.

Настройте кнопки CAP и Toggle Source для управления декой. Откройте окно 
Deck Controller, чтобы перемотать ленту и начать воспроизведение.

559Работа с программами других производителей



Пакетная запись при помощи UltraStudio и DeckLink
Регистрация клипов при пакетной записи

1	 Выберите File > Input > Tape Capture, чтобы открыть Capture Tool.

2	 Чтобы переключиться с режима Satellite на Deck, нажмите кнопку Toggle Source. 
Нажмите кнопку Capture/Log Mode. Появится значок LOG.

3	 Выполните настройки входов видео и аудио, исходных видео- и аудиотреков, 
целевой папки, разрешения, целевого диска и названия ленты так же, как 
описано в разделе «Захват видео с устройств без функции дистанционного 
управления».

4	 С помощью окна Deck Controller или клавиш J, K, L можно выполнять перемотку 
вперед и назад, ставить на паузу и находить видео для захвата.

5	 Нажмите на кнопку Mark IN/OUT слева от кнопки LOG. Значок будет меняться 
между IN и OUT, поэтому надо нажать всего одну кнопку для регистрации точек 
входа и выхода, а также для регистрации клипа. Этот способ более удобен, чем 
использование двух кнопок Mark IN и Mark OUT в окне Deck Controller. Кроме 
того, для указания точек входа и выхода можно использовать клавиши I и O, а 
также горячую кнопку F4 для регистрации клипа.

Нажмите на кнопку Mark IN/OUT или воспользуйтесь  
клавишами I и O для указания точек входа и выхода

6	 После регистрации клипов закройте панель Capture Tool, откройте папку Logging 
bin и выберите клипы для захвата.

7	 Выберите Clip > Batch Capture. Укажите нужные опции в диалоговом окне 
и нажмите ОК.
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Запись на пленку с помощью UltraStudio и DeckLink
После того как вы записали клипы, перетащили их на монтажную линейку, 
отредактировали и добавили эффекты, можно создать завершенный проект на пленке.

1	 Чтобы открыть последовательность в окне монтажной линейки, дважды 
щелкните по ней кнопкой мыши.

2	 Выберите File > Output > Digital Cut, чтобы открыть Digital Cut Tool.

3	 Для настройки Output Mode выберите опцию Real-Time, для Bit Depth — 10-bit. 
Для записи всей последовательности поставьте флажок в поле Entire Sequence, а 
для Deck Control укажите опцию Remote.

4	 Для более точного монтажа на ленту с тайм-кодом выберите Insert Edit или 
Assemble Edit. Можно также воспользоваться функцией Crash Record. Когда 
монтаж в режиме вставки является единственным возможным способом, 
перейдите на вкладку Settings в проекте, дважды щелкните кнопкой мыши Deck 
Preferences и включите опцию “Allow assemble edit & crash record for digital cut”.

5	 Если название деки выделяется курсивом или появляется сообщение “NO 
DECK”, выберите Check Decks в меню. При правильной настройке название деки 
должно отображаться без курсива.

6	 Нажмите кнопку Play Digital Cut (значок в виде красного треугольника) для записи 
последовательности на пленку.

Кнопка Digital Cut для записи на пленку
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7	
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Blackmagic Media Express

Обзор Blackmagic Media Express
Приложение Blackmagic Media Express поставляется в комплекте с UltraStudio, DeckLink 
и Intensity, а также с видеомикшерами ATEM, Blackmagic Camera, H.264 Pro Recorder, 
Teranex Processor и Universal Videohub. Это идеальное решение, если вы хотите 
записывать, воспроизводить и копировать видеоклипы на пленку без сложных 
приложений для нелинейного монтажа. 

Запись видео- и аудиофайлов

Создание проекта
Media Express автоматически определяет формат входящего видеосигнала и использует 
его для проекта. Для выбора вручную выполните перечисленные ниже действия.

1	 Выберите Media Express>Preferences на Mac или Edit>Preferences, если вы 
работаете с Windows или Linux. Из раскрывающегося меню Project Video Format 
в окне Preferences выберите один из предлагаемых форматов. Раскрывающееся 
меню Capture File Format позволяет выбирать различные сжатые и несжатые 
форматы, а также DPX. Захват видео будет выполняться в выбранном формате 
с сохранением в файле QuickTime movie. Можно также вести запись из RGB-
источников с использованием кодека YUV и наоборот.

Перейдите в окно Preferences, чтобы настроить формат видео 
и захвата, место сохранения файлов и другие опции
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2	 Укажите место сохранения записываемого видео и аудио. Нажмите кнопку 
Browse, чтобы выбрать папку на компьютере.

3	 Укажите, нужно ли остановить захват или воспроизведение при обнаружении 
пропущенных кадров.

Для проектов со стандартным разрешением используется формат кадра 4:3, если не 
выбрана опция Use Anamorphic SD 16:9. 

Если окно программы свернуть, воспроизведение видео обычно останавливается. 
Выберите опцию "Continue playback when in the background", если вы не хотите 
останавливать воспроизведение в Media Express при открытии другого приложения.

Последние опции относятся к видеомагнитофонам с портом RS-422 и предусматривают 
ранний запуск и смещение тайм-кода.

Захват
Чтобы приступить к записи, достаточно подключить источник видео. После того как 
Media Express определит формат входящего сигнала, нажмите кнопку Capture.

Добавьте описание видео

Папки 
клипов

Опции  
записи

Органы  
управления

Сохранение  
статичных  

изображений

Название проекта,  
формат видео и частота 

кадров

Индикатор 
дистанционного  

управления

Регистрационные  
данные

Точки  
входа/  
выхода

Индикаторы  
звука

Включить/  
отключить  

аудиоканал

Media List
Поисковая 

строка
Режимы Timecode List, 
Thumbnail и Favorites

Тайм-код 
видеомагнитофона/деки

Предварительный 
просмотр
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1	 Подключите источник видеосигнала ко входу оборудования Blackmagic Design. 
Запустите Desktop Video Setup и убедитесь в том, что для настройки Input 
Connection выбран тот же вход, например SDI, HDMI или компонентный.

2	 Откройте Media Express и выберите вкладку Log and Capture.

3	 Источник видео будет отображаться на панели предварительного просмотра. 
Введите описание в строке Description.

4	 Нажмите кнопку "+" рядом с полем Description, чтобы добавить текст в строку 
Name. Нажмите кнопку "+" рядом с любым другим полем, которое нужно добавить 
к строке Name.

	ͽ Чтобы увеличить значение строки, нажмите на изображение хлопушки. Можно 
ввести описание и номер в любой строке вручную.

	ͽ Описание в строке Name будет применено к следующему записанному клипу.

	ͽ Если вы хотите пометить клип как избранный, нажмите значок с изображением 
звездочки рядом со строкой Name.

	ͽ Нажмите "!" рядом со строкой Name, после чего появится запрос на 
подтверждение названия клипа.

5	 Выберите нужное количество аудиоканалов для захвата.

Выберите нужное количество аудиоканалов для захвата

6	 Нажмите кнопку Capture, чтобы начать запись. Для остановки записи 
и сохранения клипа нажмите кнопку Capture еще раз или клавишу ESC. 
Записанные клипы будут добавлены к списку Media List в левой части 
Media Express.

Нажмите кнопку Capture для начала захвата

Если форматы входящего сигнала и проекта не совпадают, появится диалоговое окно 
с предложением создать новый проект и сохранить текущий.

Blackmagic Media Express автоматически определяет изменение формата на программном 
выходе видеомикшера ATEM, предлагая сохранить текущий проект и создать новый
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Регистрация клипов
Убедитесь в том, что видеооборудование Blackmagic Design и дека соединены 
последовательным кабелем через порт RS-422. 

Убедитесь, что для переключателя Remote/Local установлена настройка Remote. 
Используйте клавиши J, K, L для перемотки назад, постановки на паузу 
и перемотки вперед.

	� Нажмите кнопку Mark In для выбора точки входа или используйте клавишу i.

	� Нажмите кнопку Mark Out для выбора точки входа или используйте клавишу o.

	� Нажмите кнопку Log Clip для регистрации клипа или используйте клавишу p. 
Должна появиться соответствующая запись в Media List с красным символом Х, 
указывающая на то, что медиаматериал еще не записан.

Пакетная запись
После регистрации клипа можно воспользоваться кнопкой Clip, чтобы записать 
отдельный клип.

Если нужно записать нескольких клипов, продолжите регистрацию клипов для 
пакетной записи.

Выберите зарегистрированные клипы из Media List, затем выполните один из 
следующих шагов.

	� Нажмите кнопку Batch.

	� Щелкните правой кнопкой мыши по нужному клипу и выберите Batch Capture.

	� Перейдите в меню File и выберите Batch Capture.

Media Express запишет клип с учетом тайм-кода точек входа и выхода.

Захват видео в формате DPX
Если необходимо выполнить захват в формате DPX, откройте настройки Media Express 
и для параметра Capture File Format выберите настройку DPX 10-Bit RGB.

	� Создайте DPX-проект, установив настройку DPX для формата записи.

	� Выполните захват видео.

Настройки захвата в формате DPX

По окончании захвата появится миниатюрное изображение клипа в Media List. Файлы в 
формате DPX сохраняются в отдельной папке на жестком диске. Аудио будет сохранено 
в той же папке в формате .wav.

По умолчанию считается, что захват видео в формате DPX ведется из YUV-источников. 
Если необходимо записать видео из RGB-источников, выберите опцию “Capture from an 
RGB source”. 

Включите опцию “Use absolute frame numbering when capturing DPX”, если вы хотите, 
чтобы нумерация DPX-кадров велась на основе тайм-кода записанного видео, а 
не с нуля.
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Если файлы в формате DPX состоят из небольшого числа последовательных кадров, 
можно сократить количество нулей в их нумерации. Для этого выберите опцию "When 
capturing DPX files, use (2-8) digit numbers in the frame count".

Захват 3D-видео
Конфигурация из Media Express и оборудования Blackmagic Design с поддержкой 
двухпотокового 3D-видео позволяет создавать 3D-видео клипы для правого и левого 
каналов, одновременно захватывая два потока HD-SDI-видео.

	� Создайте 3D-проект с частотой кадров, соответствующей источнику 
двухпотокового 3D-видео.

	� При записи из SDI-источника проверьте наличие двух отдельных входов HD-SDI 
на оборудовании Blackmagic.

	� Выполните захват видео.

Для записи 3D-клипов двухпотокового стереоскопического  
видео выберите формат, в названии которого есть "3D"

При захвате и регистрации двухпотокового 3D-видео в Media Express название клипа 
будет отображаться в левом канале. К названию правого канала будет добавлен текст 
"_right". Например, если стереоклипу присвоить название "Clip 1", клип левого канала 
будет отображаться как "Clip 1.mov", а правого — "Clip 1_right.mov".

Media List позволяет легко распознать 3D-клипы.

	� Клипы для левого и правого каналов объединяются с помощью 3D-индикатора 
в списке Thumbnail и изображены в виде одного большого значка.

	� В списке Timecode List клипы для левого и правого каналов отображаются в двух 
строках и объединяются с помощью 3D-индикатора.

Клипы для левого и правого каналов 
объединяются с помощью 3D-индикатора 
в списке Thumbnail и изображены 
в виде одного большого значка
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Воспроизведение видео- и аудиофайлов

Воспроизведение одного и нескольких клипов
Чтобы воспроизвести один клип из списка Media List, дважды щелкните по нему кнопкой 
мыши. Можно также выбрать нужный клип в Media List и нажать клавишу пробела либо 
кнопку Play на панели управления воспроизведением.

Панель управления с функциями воспроизведения, остановки,  
перехода к следующему клипу и циклического воспроизведения

Для воспроизведения нескольких клипов выберите нужные файлы из списка Media List 
и нажмите клавишу пробела или кнопку Play на панели управления воспроизведением.

Видео будет воспроизводиться на панели предварительного просмотра Media Express 
с выводом на все выходы решения Blackmagic Design. Во время воспроизведения можно 
включать/отключать аудиоканалы, используя кнопки enable/disable.

Импорт клипов
После того как видео- и аудиофайлы импортированы в Media Express, их можно 
воспроизвести несколькими способами.

	� Дважды щелкните кнопкой мыши по пустому месту в Media List, перейдите к 
папке с файлами и выберите Open (Открыть).

	� Щелкните правой кнопкой мыши по пустому месту в Media List и в контекстном 
меню выберите Import Clip (Импортировать клип).

	� Перейдите в меню File, выберите Import, затем Media Files.

Папки  
клипов

Избранное Органы  
управления

Сохранение 
статичных  

изображений

Название 
проекта, формат 
видео и частота 

кадров

Индикатор 
дистанционного 

управления

Информация  
о клипе

Точки 
входа/  
выхода

Индикаторы  
звука

Включить/  
отключить  

аудиоканал

Media List
Поисковая  

строка
Режимы Timecode List, 
Thumbnail и Favorites

Тайм-код 
видеомагнитофона/деки

Предварительный  
просмотр
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Выберите видео- и аудиоклипы для импорта и нажмите Open (Открыть). Клипы будут 
отображаться в поле Scratch списка Media List. Если вы создали собственные папки в 
списке Media List, клипы можно перетащить в нужную папку.

Чтобы импортировать файлы в папку, щелкните правой кнопкой мыши по нужной папке 
и в контекстном меню выберите Import Clip.

Если размер и частота кадров импортируемых файлов не совпадают с параметрами 
клипов в Media List, появится диалоговое окно с предложением создать новый проект 
и сохранить текущий.

Если параметры импортированных и существующих клипов не совпадают, 
появится сообщение с предложением создать новый проект

СОВЕТ.  Media Express также поддерживает импорт многоканальных 
аудиофайлов, записанных в несжатых форматах WAVE и AIFF с частотой 48 кГц.

Импорт файлов можно также осуществить с помощью XML-файла из таких программ, как 
Final Cut Pro 7 или Final Cut Pro X. Перейдите в меню File, выберите Import, затем Final Cut 
Pro X XML или Final Cut Pro 7 XML. Откройте нужный XML-файл. В окне Media List появятся 
все папки и файлы проекта из Final Cut Pro.

Media Express также поддерживает импорт CMX EDL-файлов для выполнения пакетной 
записи с использованием EDL-файлов из других программ. Перейдите в меню File, 
выберите Import, затем CMX EDL. Выберите EDL-файл и откройте его. 

Можно импортировать файлы напрямую  
и с помощью XML или EDL

В окне Media List появятся регистрационные данные. Выберите клипы и выполните 
пакетную запись, чтобы импортировать клипы с видеомагнитофона.
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Просмотр файлов

Режим Thumbnail
Пиктограммы являются наиболее простым способом навигации. Наведите курсор мыши 
на пиктограмму клипа и щелкните кнопкой на значке, который появляется в правом 
нижнем углу. Чтобы скрыть данные, нажмите на всплывающую подсказку.

Нажмите на значок для просмотра сведений о клипе

Режим Timecode List
Для просмотра клипов в режиме Timecode List нажмите соответствующую кнопку 
в правом верхнем углу Media List. Информацию о клипах можно просмотреть с помощью 
горизонтальной полосы прокрутки.

В окне Media List можно просматривать клипы в режиме Timecode List или 
Thumbnail. Нажмите кнопку Favorites для отображения только избранных 
клипов. В поисковой строке наберите название избранного клипа.

Создание и использование папок
Чтобы создать папку, щелкните правой кнопкой мыши на пустом поле окна Media List 
и выберите Create Bin. Введите название новой папки.

Клипы можно перетаскивать из папки в папку. Если вы хотите поместить клип 
в несколько папок, его следует повторно импортировать, щелкнув правой кнопкой мыши 
по нужной папке и выбрав Import Clip.

По умолчанию зарегистрированные клипы отображаются в поле Scratch. Если нужно 
зарегистрировать клипы и поместить их в новую папку, щелкните правой кнопкой мыши 
по новой папке и выберите Select As Log Bin.

Избранные клипы
Чтобы добавить клип в избранное, на вкладке Log and Capture нажмите значок 
звездочки рядом со строкой Name.

Если нажать значок звездочки на вкладке Playback, клип будет добавлен в избранное, 
когда он выбран в Media List. Чтобы отменить выбор, еще раз нажмите значок звездочки.

В режимах Timecode List и Thumbnail рядом с избранными клипами отображается желтая 
звездочка.
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Пометив клипы как избранные, нажмите кнопку Show only favorites в верней части окна 
Media List. Звездочка загорится желтым цветом. После этого будут отображаться только 
избранные клипы. 

Чтобы добавить клип в избранное, на вкладке Log and Capture 
нажмите значок звездочки рядом со строкой Name

Объединение аудио- и видеоклипов
Порядок объединения аудио- и видеоклипов в Media List

	� Выберите видеоклип, не имеющий аудиоканалов.

	� Щелкните правой кнопкой мыши на видеоклипе и в контекстном меню выберите 
Link Audio File.

	� Выберите аудиофайл для объединения с видео и нажмите Open. Аудио- и 
видеоклипы будут объединены в окне Media List.

В окне Media List для клипов в формате 3D 
используется наглядное обозначение, которое 
показывает, что видео- и аудиофайлы объединены

Теперь этот клип готов к воспроизведению или к записи на мастер-копию.

Удаление клипов и папок
Чтобы удалить ненужные клипы, выберите их и нажмите на клавиатуре клавишу 
возврата. 

Клипы удаляются только из списка Media List, но остаются на жестком диске.

Чтобы удалить папку, щелкните на ней правой кнопкой мыши и выберите Delete Bin. 
Выбранная папка и находящиеся в ней клипы будут удалены. Клипы удаляются только из 
списка Media List, но остаются на жестком диске.
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Создание 3D-клипа
Порядок добавления стереоскопического 3D-видеоклипа в список Media List

	� Выберите проект в формате 3D с такой же частотой кадров, как 3D-контент.

	� Импортируйте файл левого канала в Media List.

	� Щелкните правой кнопкой мыши на файле левого канала и в контекстном меню 
выберите Set Right Eye Clip. Если клип правого канала уже записан программой 
Media Express, к его названию будет добавлен текст "_right".

Выберите формат 3D-проекта

В окне Media List для клипов в формате 3D используется наглядное обозначение. Клипы 
для правого и левого каналов расположены рядом друг с другом в окне Video Preview, 
что указывает на 3D-формат проекта.

В окне Media List для клипов в формате 3D 
используется наглядное обозначение

Если каналы 3D-стереоклипа отображаются наоборот:

	� Щелкните правой кнопкой мыши по 3D-клипу в окне Media List.

	� В контекстном меню выберите "Swap Eyes".

Поиск по списку Media List
Чтобы найти нужный клип в проекте, наберите его имя в строке Search вверху окна 
Media List. В сочетании с функцией отбора избранных файлов это позволяет сократить 
время поиска.

В поисковой строке наберите название клипа
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Видео- и аудиомонтаж на ленту
Хотя по традиции обычно используют термин «лента», в действительности дека может 
работать с пленками или дисками. Монтаж клипов выполняется в описанной ниже 
последовательности.

	� Выберите клипы, которые вы хотите записать на ленту.

	� Выберите голубую вкладку Edit to Tape.

	� Установите точку входа и тип редактирования.

	� Выполните запись на ленту.

Выбор клипов для монтажа
Из списка Media List выберите клипы, которые нужно записать на ленту. Можно вставить 
многоканальные аудиотреки, заменив ими основную звуковую дорожку на мастер-копии. 
Если вы хотите записать избранные клипы, нажмите значок звездочки в верхней части 
Media List для отображения только этих клипов. Затем выберите клипы.

Нажмите на значок «Избранное» (звездочка) вверху списка  
Media List для отображения только избранных клипов

Монтаж на ленту в режимах Insert и Assemble
Выберите вкладку Edit to Tape. Введите точку входа, набрав тайм-код в поле In, или 
перейдите к нужному фрагменту с помощью панели управления воспроизведением, а 
затем нажмите кнопку Mark In.

Если точка выхода не введена, Media Express установит длительность редактирования 
как общую протяженность клипов в списке Media List. Если точка выхода определена, 
Media Express остановит запись после того, как будет достигнут тайм-код точки выхода.

Режимы 
записи

Запись  
на ленту

Включить/отключить 
аудиоканал

Точки входа/ 
выхода
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Для вывода на ленту выбраны два клипа

Выберите режим редактирования Assemble или Insert. Затем нажмите кнопку Master.

Режим просмотра имитирует процесс редактирования без записи на ленту. В этом 
режиме можно проверить место монтажа. Полученный в режиме Preview материал 
следует просмотреть на мониторах, подключенных непосредственно к выходу деки. Это 
позволяет одновременно отображать уже записанный на ленту и новый видеоматериал. 

Если на деке или кассете включен предохранитель от случайной записи, программа 
Media Express сообщит об этом при нажатии кнопки Master. Для продолжения записи 
отключите предохранитель.

С помощью кнопок «включить/выключить» выберите аудиоканалы для вывода. Отмените 
выбор видеоканала, если требуется вывод только звука.

Установите нужное количество аудиоканалов для монтажа

Нажмите на значок «Избранное» (звездочка) вверху списка Media List для отображения 
только избранных клипов. Для вывода на ленту выбраны два клипа. Установите нужное 
количество аудиоканалов для монтажа.

Запись H.265-видео
Порядок захвата видео с помощью кодера H.265 на Blackmagic UltraStudio 4K Extreme

1	 Откройте Preferences и для настройки Capture File Format выберите опцию 
MP4 H.265.

2	 Чтобы задать битрейт, нажмите кнопку Quality рядом с настройкой H.265 
и передвиньте слайдер Encoding Settings влево или вправо. Для сохранения 
настроек закройте окно Encoding Settings. 

СОВЕТ.  Подробнее о настройках битрейта и захвата в стандарте H.265 см. 
следующий раздел «Аппаратное кодирование с помощью H.265».

574Blackmagic Media Express



Кодер H.265

Запись H.265-видео с помощью UltraStudio 4K Extreme
Blackmagic UltraStudio 4K Extreme имеет встроенный аппаратный кодер для захвата 
H.265‑файлов в режиме реального времени. Это позволяет записывать видео очень 
высокого качества с максимально низким битрейтом.

Чтобы записать видео в H.265 с помощью Blackmagic UltraStudio 4K Extreme,  
в настройках Media Express Preferences выберите формат MP4 H.265 

Захват видео с помощью кодера H.265
1	 Запустите приложение Blackmagic Media Express Откройте Preferences и для 

настройки Capture File Format выберите MP4 H.265.

2	 Чтобы задать битрейт, нажмите кнопку Quality рядом с настройкой H.265 
и передвиньте слайдер Encoding Settings влево или вправо. Для сохранения 
настроек закройте окно Encoding Settings. Теперь Blackmagic UltraStudio 4K 
Extreme будет создавать H.265-видео с помощью Blackmagic Media Express. 
Подробнее о захвате и воспроизведении видео с использованием Media Express 
см. раздел "Blackmagic Media Express".

Настройка битрейта
По умолчанию используется битрейт 15 Мбит/с, который позволяет вести запись 
высокого качества в формате Ultra HD для потоковой передачи через Интернет. При 
необходимости можно задать любое значение в диапазоне от 3 до 50 Мбит/с. Для 
потоковой трансляции HD-видео рекомендуется выбирать значение именно в этом 
диапазоне.

Передвиньте слайдер Encoding Settings влево для записи видеофайла меньшего 
размера с низким битрейтом. Если необходимо самое высокое качество записи и нет 
ограничений по размеру файла, передвиньте слайдер вправо. Слишком низкий битрейт 
приводит к появлению заметных артефактов, таких как мозаика, пикселизация или 
полосы. Кодер H.265 сводит эти погрешности к минимуму, поэтому по сравнению с H.264 
для него можно выбрать меньшее значение битрейта.
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Чтобы задать битрейт для H.265, нажмите кнопку Quality и передвиньте 
слайдер Encoding Settings влево или вправо

При использовании H.265 или любого другого кодека для создания видео, 
предназначенного для потоковой трансляции, следует учитывать несколько факторов 
— пропускную способность системы передачи, динамику и контрастность между 
кадрами, а также кадровую частоту. Например, при большом количестве запросов на 
просмотр видео через Интернет рекомендуется выбирать невысокий битрейт. В этом 
случае зрители с более медленным соединением смогут смотреть запись без 
технических сбоев. Высокий битрейт подходит для материала с большой градацией 
контраста и динамичной сменой изображений — при переходе от яркого к темному 
кадру, показе спортивных мероприятий и использовании графики. Для видео с высокой 
кадровой частотой также требуется более высокий битрейт.

Выбрать оптимальный битрейт можно опытным путем. Чтобы получить наилучшее 
качество при небольших размерах файла, попробуйте несколько разных значений.

Blackmagic Disk Speed Test

Что такое Blackmagic Disk Speed Test?
Blackmagic Disk Speed Test проверяет дисковые массивы на производительность и 
отображает результаты тестирования в кадрах в секунду. Утилита поставляется вместе с 
приложением Desktop Video, а также доступна для бесплатной загрузки в магазине App 
Store для применения на платформе macOS. Перейдите в настройки Disk Speed Test, 
нажав кнопку Settings, расположенную над кнопкой «Старт».

Выбор целевого диска
Нажмите Select Target Drive и убедитесь в том, что у вас есть права на 
чтение и запись.

Сохранение снимка экрана
Нажмите Save Screenshot, чтобы сохранить снимок рабочего окна с результатами 
проверки. 
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Нагрузка
Уровень нагрузки может быть настроен в диапазоне от 1 до 5 ГБ c шагом 1 ГБ. 
Нагрузка 5 ГБ установлена по умолчанию и обеспечивает наиболее точные 
результаты.

Откройте меню Settings,  
нажав на значок настроек

Помощь в работе с Disk Speed Test
Чтобы открыть руководство по эксплуатации в формате PDF, нажмите на 
Disk Speed Test Help. 

About Disk Speed Test
About Disk Speed Test отображает установленную версию утилиты 
Disk Speed Test.

Start
Нажмите кнопку Start, чтобы начать работу. Disk Speed Test проверит скорость 
чтения и записи на жесткий диск. Программа Disk Speed Test будет вести 
проверку до тех пор, пока вы снова не нажмете кнопку Start.

Will it Work?
Панель Will it Work? отображает распространенные форматы видео с галочкой 
или крестиком, визуально показывая производительность диска. Следует 
провести несколько циклов тестирования, чтобы выявить форматы, для которых 
производительность диска может быть недостаточной. Если на панели 
попеременно отображаются галочка и крестик, это означает, что жесткий диск не 
будет надежно поддерживать данный формат.

How Fast (FPS)
Панель How Fast? (FPS) показывает поддерживаемую диском частоту кадров 
и используется в сочетании с панелью Will it Work?. Когда панель Will it Work? 
отображает зеленую галочку для комбинации 2K DCI 25p и 10 Bit YUV 4:2:2, 
а панель How Fast? (FPS) показывает 25 fps, производительность диска 
недостаточно высокая.
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Настройки

Перед началом проверки 
нажмите эту кнопку, чтобы 
установить необходимые 
настройки.

START 
Нажмите эту кнопку один раз 
для начала проверки. Повторно 
нажмите кнопку START, чтобы 
остановить проверку.

How Fast (FPS) 
Эта панель отображает результаты 
проверки в кадрах в секунду (fps).

Will it Work? 
Эта панель показывает, какие форматы 
видео поддерживаются диском.
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Снятие мезонинной платы 
с DeckLink 4K Extreme 12G 

Порядок снятия мезонинной платы 
Если на материнской плате недостаточно места для размещения PCIe с двумя слотами, 
можно снять мезонинную плату с DeckLink 4K Extreme 12G.

Порядок снятия мезонинной платы
1	 Примите меры для снятия статического заряда. Положите плату DeckLink боком 

на ровную и чистую поверхность так, чтобы позолоченные контакты были 
направлены вверх.

2	 На нижней части платы DeckLink найдите два винта, которые используются для 
крепления мезонинной платы. С помощью отвертки Phillips аккуратно открутите 
винты, наиболее удаленные от разъема BNC.

3	 Держа плату DeckLink за края, аккуратно поднимите мезонинную плату, чтобы 
соединительный коннектор вышел из слота.

4	 Убедитесь в том, что коннектор прочно соединен с мезонинной платой, если вы 
планируете ее повторную установку. 

5	 Закрутите винты в стойки мезонинной платы. Для ее хранения следует 
использовать антистатическую сумку.

Плата DeckLink 4K Extreme 12G готова к установке в компьютер с использованием 
одного слота.

Порядок обратной установки мезонинной платы
1	 Совместите две стойки мезонинной платы с отверстиями по бокам DeckLink 

и аккуратно прикрепите плату к соединительному коннектору с помощью винтов. 
Проверьте надежность установки мезонинной платы в слоте коннектора. 

2	 Закрепите стойки мезонинной платы на основании DeckLink с помощью винтов 
и отвертки Phillips. Не затягивайте винты слишком сильно.

Ответы на вопросы и помощь можно получить в разделе поддержки на странице  
www.blackmagicdesign.com/ru/support.

DeckLink 4K Extreme 12G имеет съемную мезонинную плату 
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Восстановление платы DeckLink 
после прерванного обновления
Если обновление программного обеспечения платы было прервано (например, из-за 
непредвиденного отключения компьютера от источника питания), ее работоспособность 
может быть нарушена. На этот случай многие модели линейки DeckLink оснащены 
специальным портом USB, который позволяет завершить обновление.

Если плата DeckLink поддерживает восстановление, она имеет порт Mini-B USB, 
расположенный на тыльной стороне или сбоку. Через этот порт ее можно подключить к 
компьютеру, чтобы выполнить обновление прямым способом.

Завершение прерванного обновления платы DeckLink
1	 Завершите сеанс работы на компьютере и отключите питание.

2	 Осторожно извлеките плату DeckLink из слота PCIe и поместите ее на устойчивую 
поверхность (например, рабочий стол). Мы рекомендуем положить плату на 
антистатический пакет и надеть на руку антистатический браслет, чтобы избежать 
риска повреждения устройства из-за возможного электрического разряда.

3	 Подключите USB-кабель к порту Mini-B USB на тыльной стороне или сбоку платы.

Извлеките плату DeckLink из слота PCIe и подключите ее к компьютеру 
через порт Mini-B USB на тыльной стороне или сбоку

4	 Подключите другой конец USB-кабеля к USB-порту компьютера.
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5	 Подсоедините компьютер к сети питания и включите его. После запуска 
ПК появится сообщение с предложением обновить программное 
обеспечение платы.

Нажмите кнопку Update.

Индикатор выполнения задачи позволяет видеть состояние обновления и 
показывает его завершение.

По окончании обновления отключите USB-кабель и установите плату обратно в 
слот PCIe на компьютере.

ПРИМЕЧАНИЕ.  Завершите сеанс работы на компьютере и отключите питание, 
прежде чем выполнять операции со слотом PCIe.

Включите питание компьютера после обратной установки платы DeckLink. Когда она 
будет распознана, можно возобновить работу.
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Помощь

Как получить помощь
Самый быстрый способ получить помощь — обратиться к страницам поддержки на сайте 
Blackmagic Design и проверить наличие последних справочных материалов по 
необходимому оборудованию.

Страница поддержки на сайте Blackmagic Design
Последние версии руководства по эксплуатации, программного обеспечения 
и дополнительную информацию можно найти в разделе поддержки Blackmagic Design на 
странице www.blackmagicdesign.com/ru/support.

Обращение в Службу поддержки Blackmagic Design
Если с помощью доступных справочных материалов решить проблему не удалось, 
воспользуйтесь формой «Отправить нам сообщение» на странице поддержки. Можно 
также позвонить в ближайшее представительство Blackmagic Design, телефон которого 
вы найдете в разделе поддержки на нашем веб-сайте.

Проверка используемой версии программного обеспечения
Чтобы узнать версию Blackmagic Desktop Video Setup, установленную на вашем 
компьютере, откройте утилиту. 

	ͽ При работе в операционной системе Mac OS X откройте Blackmagic Desktop 
Video Setup в папке «Приложения». Чтобы узнать версию программного 
обеспечения, выберите About Blackmagic Desktop Video Setup. 

	ͽ При работе в операционной системе Windows 8 и 8.1 на экране «Пуск» введите 
Blackmagic, затем выберите Blackmagic Desktop Video Setup. Чтобы узнать 
версию программного обеспечения, выберите About Blackmagic Desktop Video 
Setup. 

	ͽ При работе в операционной системе Windows 10 на экране «Пуск» введите 
Blackmagic в поисковой строке. Затем выберите Blackmagic Desktop Video 
Setup. Чтобы узнать версию программного обеспечения, выберите About 
Blackmagic Desktop Video Setup.

	ͽ При работе в операционной системе Linux выберите Applications > Sound and 
Video > Blackmagic Desktop Video Setup. Чтобы узнать версию программного 
обеспечения, выберите About Blackmagic Desktop Video Setup.

Загрузка последних версий ПО
Узнав установленную версию Blackmagic Desktop Video Setup, перейдите в центр 
поддержки Blackmagic Design на странице www.blackmagicdesign.com/ru/support, чтобы 
проверить наличие обновлений. Рекомендуется всегда использовать последнюю 
версию программного обеспечения, однако обновление лучше всего выполнять после 
завершения текущего проекта. 

Чтобы узнать дату последнего обновления драйвера, перейдите на вкладку About 
в утилите Blackmagic Desktop Video Setup. Дополнительно можно создать отчет 
состояния, нажав на кнопку Create в Status report.
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Информация для разработчиков
Создание собственного программного обеспечения для работы 
с оборудованием Blackmagic Design
Пакет SDK для DeckLink позволяет разработчикам управлять оборудованием Blackmagic 
с помощью собственного программного обеспечения. Пакет SDK для DeckLink 
поддерживает решения UltraStudio, DeckLink и Intensity.

Он дает разработчикам возможность работать со сложными задачами на уровне 
аппаратного управления и выполнять типовые действия обычного пользователя. Пакет 
SDK для DeckLink поддерживает следующие технологии:

	ͽ DeckLink API

	ͽ Apple QuickTime

	ͽ Apple Core Media 

	ͽ Microsoft DirectShow

Как загрузить бесплатный пакет SDK
Пакет SDK для DeckLink можно загрузить, перейдя по ссылке 
www.blackmagicdesign.com/ru/support.

Форум Blackmagic Design для разработчиков
Форум Blackmagic Design предназначен для обсуждения технических вопросов работы 
с кодеками, медиаматериалами, API и SDK. На нем можно поделиться своими идеями 
и получить помощь от персонала поддержки Blackmagic Design и других пользователей.  
Форум для разработчиков находится на веб-сайте Blackmagic Design по адресу forum.
blackmagicdesign.com.

Обращение в службу поддержки Blackmagic Design для разработчиков
Если у вас возникли вопросы, которые не обсуждались на форуме Blackmagic Design  
для разработчиков программного обеспечения, напишите нам по 
адресу developer@blackmagicdesign.com.
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Соблюдение нормативных требований
Утилизация электрооборудования и электронной аппаратуры в Европейском Союзе
Изделие содержит маркировку, в соответствии с которой его запрещается 
утилизировать вместе с бытовыми отходами. Непригодное для эксплуатации 
оборудование необходимо передать в пункт вторичной переработки. Раздельный 
сбор отходов и их повторное использование позволяют беречь природные ресурсы, 
охранять окружающую среду и защищать здоровье человека. Чтобы получить 
подробную информацию о порядке утилизации, обратитесь в местные муниципальные 
органы или к дилеру, у которого вы приобрели это изделие.

Данное оборудование протестировано по требованиям для цифровых устройств класса 
A (раздел 15 спецификаций FCC) и признано соответствующим всем предъявляемым 
критериям. Соблюдение упомянутых нормативов обеспечивает достаточную защиту от 
вредного излучения при работе оборудования в нежилых помещениях. Так как это 
изделие генерирует и излучает радиоволны, при неправильной установке оно может 
становиться источником радиопомех.  
Если оборудование эксплуатируется в жилых помещениях, высока вероятность 
возникновения помех, влияние которых в этом случае пользователь должен  
устранить самостоятельно.

До эксплуатации допускаются устройства, соответствующие двум главным требованиям.

1	 Оборудование не должно быть источником вредных помех. 

2	 Оборудование должно быть устойчивым к помехам, включая помехи,  
которые могут вызвать сбой в работе.

Соответствие требованиям ISED (Канада)
Данное оборудование соответствует канадским стандартам для цифровых 
устройств класса A.

Любая модификация или использование изделия не по назначению могут повлечь за 
собой аннулирование заявления о соответствии этим стандартам.

Подключение к HDMI-интерфейсу должно выполняться с помощью качественного 
экранированного кабеля.

Данное оборудование протестировано по требованиям, предъявляемым  
к устройствам при работе в нежилых помещениях. При использовании в бытовых 
условиях оно может становиться источником помех для радиосигнала.
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Правила безопасности
Во избежание удара электрическим током розетка для подключения устройства к сети 
должна иметь заземляющий контакт. При необходимости обратитесь за помощью 
к квалифицированному электрику.

Чтобы минимизировать опасность поражения электрическим током, изделие необходимо 
защищать от попадания брызг и капель воды.

Допускается его эксплуатация в условиях тропического климата с температурой 
окружающей среды до 40ºC. 

Для работы устройства необходимо обеспечить достаточную вентиляцию.

При установке в стойку убедитесь в том, что не нарушен приток воздуха.

Внутри корпуса не содержатся детали, подлежащие обслуживанию. Для выполнения 
ремонтных работ обратитесь в местный сервисный центр Blackmagic Design.

Ряд оборудования позволяет установить компактный оптический SFP-модуль. 
Используйте только модули типа Laser class 1.

Рекомендуемые типы SFP-модулей

	ͽ 3G-SDI: PL-4F20-311C

	ͽ 6G-SDI: PL-8F10-311C

	ͽ 12G-SDI: PL-TG10-311C

Допускается эксплуатация в местах не выше 2000 метров над уровнем моря.

Уведомление для жителей штата Калифорния
При работе с этим оборудованием существует возможность контакта с содержащимися в 
пластмассе микропримесями многобромистого бифенила, который в штате Калифорния 
признан канцерогеном и увеличивает риск врожденных дефектов и пороков 
репродуктивной системы.

Подробную информацию см. на сайте www.P65Warnings.ca.gov.

Предупреждения для технического персонала

Перед обслуживанием отключите питание на обоих силовых разъемах.

Осторожно: плавкий предохранитель двухполюсный/в нейтрали 
Блок питания в этом устройстве имеет предохранитель в линейном и 
нейтральном проводах и подходит для подключения к системе энергопитания 
типа IT в Норвегии.
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